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Introduction

Welcome to this First Steps guide, which we have created to help you get started with Dorico by
taking you through all the steps necessary to create and prepare a short piano piece, followed by
an extract of a blues song.

We hope that the principles and techniques you learn as part of this guide help you become
familiar with common operations and feel more confident when working on your own projects.

This guide introduces you to the following:

e The user interface and its most important parts
e The different modes in Dorico and their functions
e Setting up a project

e Writing music and adding the notations required to produce a short piano piece and some
additional common notations in a separate piece

e Laying out and formatting pages, including adjusting notations such as beam grouping and
stem directions

e Playing back music and adjusting playback
e Printing and exporting

The piano piece used in these tasks is Dora Pejacevic¢'s “Walzer-Capricen No. 2". A PDF of the full
piece is available on steinberg.help for your reference.

Within a relatively short duration, this piece contains many notations common to most musical
styles, such as dynamics and articulations, as well as notes in multiple voices simultaneously,
chords, and cross-staff beaming. Other common notations not included in this piece, such as
lyrics and chord symbols, are in a separate section at the end of the guide.

NOTE

e Screenshots in this guide show Dorico Pro. Tasks are possible in all product versions unless
stated otherwise.

e For further information about anything mentioned in this guide, see the Operation Manual.

Tour of the user interface

In Dorico, the user interface is everything within the project window. Its basic structure is the
same in all modes.

The project window looks like this and consists of the following areas:
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Tour of the user interface
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Untitled Project 1

1. Flow 1

Toolbar
The toolbar is located at the top of the project window.

On the left of the toolbar, there are the buttons for the different modes. By changing the
mode, you change the workspace and the available panels. The button for the current mode
appears highlighted. You can find out more about modes in the next topic.

NOTE

Dorico SE does not have an Engrave button as it does not have Engrave mode.

In the middle of the toolbar, there is the layout selector, which allows you to change the
layout shown in the music area, and buttons to show/hide zones and tabs.

On the right of the toolbar, there are buttons for hiding/showing the Video, Mixer, and
Transport windows, and a mini transport with playback and recording controls.

Tab bar

The tab bar is located towards the top of the project window, between the toolbar and the
music area. It is available in Setup, Write, and Engrave modes.

The tab bar shows the tabs that are currently open, the name of the layout open in each
tab, and allows you to open more tabs. If you split the music area and open several tabs, tab
groups are shown.

Central area

The central part of the project window where you work on your project. When you set up
a new empty project, this area in Setup, Write, and Engrave modes shows the project start
area that allows you to add your first players.

Once you have added a player or an ensemble, this area becomes the music area that
displays the scores and instrumental parts that you create.

In Play mode, this area contains a track overview, which displays the tracks in the selected
layout and flow.

In Print mode, this area becomes the print preview area, which shows a preview of how
layouts will appear when printed onto paper or exported into a graphics file format.
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Functions of the modes

TIP

Scores and instrumental parts are known as “layouts” in Dorico. Layouts allow you to show
different presentations of your music. In a project with separate instrumental parts, such as
a string quartet, you can switch between showing the full score layout and each part layout
in the current tab. You can have as many or as few tabs open as you want.

Toolboxes

Toolboxes are the columns on the left and right edges of the project window. They contain
different tools and options according to the current mode. Toolboxes allow you to input and
modify notes, notation items, and frames, and to determine which panels are shown in their
corresponding zones.

You cannot hide toolboxes, they are always shown.
Zones

Zones are areas on the left, right, and lower edges of the project window. They contain
panels that provide the notes, notations, and functions that you need to set up, write, edit,
and format your music. Different panels are available in each zone according to the mode.
For example, the left zone in Write mode contains the Notes panel, which provides durations
for notes, common accidentals, slurs, and articulations.

You can hide and show zones either individually or together. To hide/show all zones, click
Hide/Restore Zones [@] in the toolbar. To hide/show individual zones, press Ctrl/Cmd-7 for
the left zone, Ctrl/Cmd-8 for the lower zone, and Ctrl/Cmd-9 for the right zone.

The panel shown in the left and right zones is determined by the current selection in the
corresponding toolbox. For the lower zone, the panel shown is determined by the current
selection in the lower zone toolbar; for example, Properties [& shows the Properties panel.

Status bar
The status bar is the strip at the bottom of the project window. It allows you to change the
rhythmic grid resolution [, the zoom, and the view and page arrangement in the music

area. The status bar also displays information about your current selection, such as the bar
number in which you have selected a note. It contains different options in different modes.

Functions of the modes

In Dorico, there are different modes: Setup, Write, Engrave, Play, and Print. Each mode
represents a different phase in the workflow of preparing scores and parts, so they contain
different toolboxes, panels, and functionality from each other.

Setup mode

In Setup mode, you can set up the fundamental elements of the project: instruments
and the players that hold them, flows, layouts, and videos. You can also determine how
they interact with each other; for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and
layouts, but you cannot select or interact with anything in the music area in Setup
mode.

Write mode

In Write mode, you can input and edit your music, including changing the rhythmic
positions of items, changing the pitch of notes, and deleting notes and items. The
available toolboxes and panels allow you to input all the notes and notation items that
are most commonly used.

By design, you cannot move notes and items graphically on the page in Write mode.
Graphical adjustments are only possible in Engrave mode.
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Dorico projects

Engrave mode (Dorico Pro and Dorico Elements)
In Engrave mode, you can make fine adjustments to the music that you input in Write
mode and determine how the pages of your project are laid out.
Because Engrave mode is focused on the formatting and appearance of layouts, you

cannot delete any notes or items, change their rhythmic positions, or change the pitch
of notes in Engrave mode.

Play mode

In Play mode, you can change how your music sounds in playback; for example, by
loading VST instruments and assigning them to tracks and voices.

You can change other aspects of playback using the Key Editor in both Write mode and
Play mode, such as inputting automation and changing the sounding duration of notes
in playback without affecting their notated duration.

Print mode

In Print mode, you can print your layouts or export them as graphics files. When
printing layouts, you can determine the paper size and other options, such as duplex
or booklet printing. When exporting layouts, you can specify different graphics file
types, such as PDF or PNG, and the information you want to include in their exported
file names.

You can switch between the modes at any time in any of the following ways:

e Press Ctrl/Cmd plus one of the numbers 1 to 5 (Ctrl/Cmd-1 for Setup, Ctrl/Cmd-2 for
Write, Ctrl/Cmd-3 for Engrave, Ctrl/Cmd-4 for Play, Ctrl/Cmd-5 for Print).
e Click the corresponding button in the toolbar.

e Choose Window > [model].

Dorico projects

A project is an individual file that contains all required musical information, including multiple
instruments, their music, and playback settings.

In Dorico, separate spans of music are known as “flows”. A flow could be a single song in an
album, a movement in a sonata or symphony, a number in a stage musical, or a short scale or
sight-reading exercise of only a few bars in length. A single project can contain any number of
flows, and each flow can use any combination of players. For example, if brass players are tacet
in one movement, you can remove them from that flow but keep them in other flows.

Players represent musicians who hold instruments. A single player represents a single person
who can play one or more instruments, such as a clarinettist who doubles on alto saxophone or
a percussionist with various percussion instruments. A section player represents multiple people
who all play the same instrument, such as a violin section in an orchestra or a soprano section

in a choir. Section players can only hold a single instrument, but they can be divided into smaller
units and onto multiple staves in Dorico Pro.

Layouts combine the musical content of flows and players with page formatting to produce
paginated music notation. You can have any number of layouts in a single project with any
combination of players and flows. For example, you can include a rehearsal piano player in the
vocal score layout without showing piano staves in the full score. Layouts share musical content
(such as the notes each instrument plays), but can have independent formatting (such as system
breaks and page turns in different places). Full score and part layouts have different default
settings; for example, multi-bar rests are automatically shown in parts, but not in scores.
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Key commands

Key commands are sets of keys that perform defined tasks when pressed together. They are
also known as “keyboard shortcuts” or “hotkeys”. Many key commands are the same on different
operating systems but some are not, and this guide distinguishes them.

When key commands use equivalent modifier keys depending on the operating system, the
modifier keys are indicated separated by a slash, with the Windows modifier key first and the
macOS modifier key second.

EXAMPLE

Ctrl/Cmd-Alt/Opt-Down Arrow means: press Ctrl-Alt-Down Arrow on Windows, Cmd - Opt-
Down Arrow on macOS.

When key commands require entirely different keys depending on the operating system, they are
indicated with the Windows key command first, followed by the macOS key command.

EXAMPLE
# (Windows) or \ (macOS) means: press # on Windows, \ on macOS.

Dorico provides multiple ways of inputting many items in order to cater for users who prefer to
use the mouse for input as well as those who prefer only to use their computer keyboard.

This guide focuses on using the keyboard in order to provide a simpler sequence of steps for you
to follow, and because Dorico’s key commands have been designed to be logical, consistent, and
accessible using a standard computer keyboard, without needing a number pad.

However, this guide also includes references to the mouse input methods along the way.

EXAMPLE
e The arrow keys on their own navigate the selection around the music area.
e Alt/Opt modifies selected items.

For example, in Write mode, adding Alt/Opt to the up/down arrow keys transposes notes by
staff position; adding Alt/Opt to the right/left arrow keys moves notes/items rhythmically.
In Engrave mode, adding Alt/Opt to any arrow key moves items a small amount graphically.

e Shift- Alt/Opt changes the duration of notes/items in Write mode.

For example, Shift-Alt/Opt-Right Arrow lengthens notes/items by the current rhythmic
grid resolution.

e Ctrl/Cmd increases the amount by which selected items are modified.

For example, in Write mode, adding Ctrl/Cmd - Alt/Opt to the up/down arrow keys
transposes notes by an octave; Ctrl/Cmd-Shift-Alt/Opt-Right Arrow doubles the duration
of notes. In Engrave mode, adding Ctrl/Cmd - Alt/Opt to any arrow key moves items a large
amount graphically.

e  Shift plus letter keys opens popovers in Write mode.
For example, Shift-D opens the dynamics popover; Shift-O opens the ornaments popover.
e  Ctrl/Cmd - Shift plus specific letter keys opens options dialogs.

For example, Ctrl/Cmd-Shift-L opens Layout Options; Ctrl/Cmd-Shift-N opens Notation
Options (Dorico Pro and Dorico Elements).




Setting up the project

To walk you through setting up the project for this solo piano piece, the following tasks cover
starting a new project, adding a piano to it, and deleting the spare part layout.

Starting a new project

The first step in producing a piece in Dorico is to start a new project. These steps describe
starting an empty project so you can learn how to add individual instruments and players
yourself.

PREREQUISITE

You have installed and opened Dorico.

PROCEDURE
e Press Ctrl/Cmd-N to start a new project.

e You can also choose File > New.

RESULT
A new project window opens.

Setup Write Engrave Play  Print ull score

Players Layouts

Start your project by adding some players

An individual player who plays one or more instruments.
Examples: Solo violin, Piano, Flute & Piccolo

tall play the same instrument.
section, Soprano as part of a choir

Add Ensemble

An easy way to add multiple players at the s
Examples: Double Woodwind, Triple Brass,

New empty projects start in Setup mode. This allows you to add players and instruments straight
away. Once you have added at least one player, the project start area in the middle becomes the
music area and shows staves.

On the left, the Players panel is where all the players in the project are listed. It's currently
empty, as you haven't added any players yet.

On the right, the Layouts panel shows a Full score layout card. This layout is automatically
created in every new project.



Setting up the project
Adding a piano player

At the bottom of the window is the Flows panel. All the flows in your project are shown here.

TIP

e Dorico provides project templates with different sets of players already included, such as a
string quartet or SSAATTBB choir.

e You can also use the Create New page in the Hub to start new projects.

Adding a piano player

The piece you are replicating is for solo piano, so you need to add a single player and assign a
piano instrument to them.

PROCEDURE
1. Press Shift-P to add a new single player and open the instrument picker.
e You can also click Add Single Player B in the project start area.

2. Enter piano into the instrument picker search box.

O\ pianol

Brass Electric Piano
Electronics Honky-tonk Piano
Fretted Instruments _
Gamelan Percussion Pianoforte
Keyboards

Orff Instruments

Pitched Percussion

Singers

Sketch

Strings

Unpitched Percussion

Woodwinds

Create Empty Kit Import Kit...

3. Click Add or press Return.

RESULT

You have added a single player and assigned a piano instrument to them. In the music area, the
required piano staves and their respective clefs appear.

In the Layouts panel on the right of the window, there is now a piano part layout in addition to
the existing full score layout. Dorico automatically creates a part layout for every player you add
to the project.

In projects with larger ensembiles, like orchestra, the Layouts panel is where you can find each
instrumental part. It is also where you can set up additional layouts, like a percussion part that
brings together the music of multiple percussion players, or a vocal score that contains the
singers and a rehearsal piano. At the end of this guide, we will touch on how to handle and look
through parts, after covering a variety of formatting options that you can apply to all types of
layouts.

10



Setting up the project
Deleting the spare layout

Full score +
Players Layouts

> W Fullscore

> B piano
Untitled Project 1

1. Flow 1

L3S0 F - "s angre

Deleting the spare layout

As this piece only involves one player, you can delete the part layout created by default and
just keep the full score. In projects that contain one player, you might find that having only one
layout makes it easier to keep track of your work.

PROCEDURE

1. Inthe Layouts panel on the right, select the Piano layout.

Layouts

> (I\J Full score

K

2. Press Backspace or Delete.

e You can also click Delete Layout | in the action bar at the bottom of the panel.

RESULT
The piano part layout is deleted, leaving only the full score layout.

AFTER COMPLETING THIS TASK
We recommend saving your project.

11



Writing music

Now that you have set up your project, you can start writing the music. The following tasks take
you through inputting the notes and notation items required for this piano piece, with a separate
task for each item for clarity, although Dorico is designed so that you can also input most items
at the same time as inputting notes and other notations: you don’t have to stop note input to add
a dynamic, for example.

Other common notations not included in this piece, such as lyrics and chord symbols, are in a
separate section at the end of the guide.

Some steps involve performing actions in specific bars. The bar number of the currently selected
item is shown in the status bar at the bottom of the window. The system track (the translucent
gray line above the system) also displays every bar number; you can hide/show the system track
by pressing Alt/Opt-T.

Popovers

During the following tasks, you will be using popovers to input notations such as key signatures
and dynamics. Popovers are temporary value fields that appear above the staff and allow you to
input different items and perform tasks using text entries.

There are specific popovers for different purposes, such as inputting key signatures or adding
notes at specific intervals above existing notes. You can only use popovers in Write mode.

N >

—
H-b e %o =2 T
o e e s
D} i '

5

The dynamics popover with an example entry

One of the key benefits of popovers is that you can use them as you input notes: once you

reach the position where you want to input a new time signature, for example, you can open the
time signatures popover using its key command, input the time signature you want, and then
continue inputting notes.

Although specific entries are required for many notations, the correct entries for different
notations are consistently and logically structured. For example, tuplets are always expressed

as a ratio, such as 3:2 or 5:4. Key signatures are expressed using upper case letters for major
keys, and lower case letters for minor keys. Time signatures are expressed as a pair of separated
numbers; common time signatures use a slash, such as 3/4 or 6/8.

You can identify popovers by the icon on their left-hand side, which are the same icons used in
the Notations toolbox on the right of the window. The Panels & and Popovers & buttons at the
top of the Notations toolbox allow you to switch between accessing panels and popovers when
you click buttons in the toolbox. Panels are another way you can input notations if you prefer to
use the mouse.

12



Writing music
Adding a key signature

Adding a key signature
All new projects in Dorico start with no key signature, which is treated as atonal; that is, without
an implied tonality. This piece is in Ab major, so you need to input a key signature.

PREREQUISITE

e You must be in Write mode. If you are, Write in the toolbar appears highlighted. If you are
not, press Ctrl/Cmd-2 or click Write in the toolbar to switch to Write mode.

e If you want to zoom in, you can do so by, for example, pressing Ctrl/Cmd-=or Z or using the
zoom options in the status bar at the bottom of the project window.

PROCEDURE
1. Click the rest on the top staff.
o)
Piano
Sy —y
7%

2. Press Shift-K to open the key signatures popover.

eﬁo ﬂ

Piano

©):

A

3. Enter Abinto the popover.

Ab|

2

¢):

Piano

S

e Upper case letters indicate major key signatures, lower case letters indicate minor key
signatures. You can also enter b for flat and # for sharp.

4. Press Return to close the popover.

RESULT

An Ab major key signature is input at the start of the rest, which is the start of the flow. It is
automatically positioned to the right of the initial clefs.

SH
Sy

Piano

Ay
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Writing music
Adding a time signature

TIP

You can also add key signatures using the Key Signatures, Tonality Systems, and Accidentals
panel on the right of the window, which you can show by clicking Panels EJ, then Key
Signatures, Tonality Systems, and Accidentals [f] in the Notations toolbox.

In the Key Signatures section, you can click the down arrow [ until the display has four flats,
choose Major at the top, and then click the key signature to input it.

Adding a time signature

All new Dorico projects start with no time signature by default. As this piece is in 3/4, it requires a
time signature.

You can input notes without a time signature, but you can only add extra bars once you have
input a time signature so Dorico knows how long the bars should be. You can change and
delete time signatures at any time: Dorico moves barlines and adjusts how notes are notated
accordingly.

PROCEDURE
1. Click the rest on the top staff.
2. Press Shift-M to open the time signatures popover.

3. Enter 3/4 into the popover.

a 3/4)

Piano

At

4. Press Return to close the popover.

RESULT

A 3/4 time signature is input at the rhythmic position of the selected rest, which is the start of the
flow. It is automatically shown to the right of both the initial clefs and key signature. There is now
a single bar’s worth of rhythmic space in the flow.

ig L 1) 4 =
o

Piano
0 B
b h N

TIP

You can also add time signatures using the Time Signatures (Meter) panel on the right of the
window, which you can show by clicking Panels g, then Time Signatures (Meter) H in the
Notations toolbox.

14



Writing music
Adding bars

Adding bars

Dorico automatically creates bars when you reach the end of the last bar as you input notes.
However, it can be helpful to have all the bars you will need in advance.

PREREQUISITE
You must have input the time signature so Dorico knows how long the bars should be.

PROCEDURE
1. Select the rest on the top staff.

e You can select items by clicking them or by using the keyboard. If nothing is selected in
the music area, pressing any of the arrow keys selects an item at the earliest rhythmic
position on the highest staff currently in view.

2. Press Shift-B to open the bars and barlines popover.

3. Enter 73 into the popover.

73
D]
Piano
IFWVB -
A%

4. Press Return to close the popover.

RESULT

73 bars are added, bringing the total number of bars in the flow to 74, the number required
for this piece. They are currently spaced narrowly because they are empty, but Dorico will
automatically adjust their width as you input notes.

Piano

Pno

AFTER COMPLETING THIS TASK

Using the key signatures popover (Shift-K), input a key signature change to Db major in bar 33,
and another back to Ab major in bar 43 using the popover entries Db and Ab respectively. Dorico
automatically shows double barlines at the key signature changes.

15




Writing music
Caret

Caret

During the following tasks, you will be using the caret to input notes. In Dorico, the caretis a
vertical line that shows the rhythmic position at which notes, chords, or notation items are input.

The caret has a note symbol beside it, which indicates the stem direction and type of the
currently selected voice. It has a + symbol if the voice is new.

Nl

J

The appearance and behavior of the caret changes depending on the input mode and the
currently selected voice number. For example, when you are inputting notes, the caret advances
to the next rhythmic position automatically after each note, but when inputting chords or notes
on tablature, the caret does not advance automatically. The caret also looks different when
inputting grace notes or notes into a slash voice, and when Insert or Chord mode is activated.

When the caret is active, notes and notations are input at its position. This allows you to input
dynamics and playing techniques in the middle of notes and tie chains, for example.

Inputting the melody on the top staff

In this piece, the melody is on the top, treble staff. For the first few bars of the melody, you need
to input individual notes in sequence.

PROCEDURE
1. Inbar 1, select the rest on the top staff.
2. Press Shift-N to start note input.

e You can tell you are in note input when the caret is activated and appears on the staff,
lines indicating the rhythmic grid appear above the staff, and Start Note Input [j is
active in the Notes toolbox. (Start Note Input [ is another way you can start note input
without using the keyboard.)

A

Piano

In the Notes panel on the left of the window, the quarter note button is highlighted. This
indicates the note duration that will be used for the next notes you input. Quarter note
(crotchet) is the default note duration when you start note input.

Quarter Note —
(Crotchet) (6) v/ :

Piano

16



Writing music

Inputting the melody on the top staff

If the Notes panel is not shown, press Ctrl/Cmd-7 or click Show Left Zone [ in the
Notes toolbox to show it.

However, the first four notes in the melody in this piece are eighth notes.

Press 5 to select eighth notes (quavers).

The key commands for note durations use the numbers at the top of your computer
keyboard, although you can also use a number pad. 6 is quarter notes (crotchets),
with smaller numbers used for smaller durations and larger numbers used for larger
durations.

The caret is still at the beginning of the bar, but the first note in the melody is on the
second beat. However, you don't need to input rests to get there.

Press Space twice to advance the caret two eighth notes.

Piano

During note input, Space advances the caret by the note duration currently selected in
the Notes panel.

Press F, then G, then A, then B to input the corresponding pitches.

The four notes are input as eighth notes starting from the caret position. Dorico
automatically beams the notes and shows a quarter note rest at the start of the bar.

Piano

Dorico uses the letters A-G on your computer keyboard for note pitches. Notes with
accidentals in the key signature automatically follow the key signature unless you specify
otherwise. So when you press A and B, an Ab and Bb are input.

The next note is a dotted half note, not an eighth note.

Press 7 to select half notes (minims), then . (period) to add a rhythm dot, making the
duration dotted half notes.

You must press . on your computer keyboard, not a numeric keypad.

Press G to input a dotted half note G.

Piano

|

L 101
1

Dorico automatically selects notes the smallest interval away from the previous note, so
here the G is input a third below, rather than a sixth above, the preceding B.

17



Writing music
Inputting the chords on the bottom staff

8. Repeat steps 3 to 7 for bars 3-4.
TIP

Alternatively, you can press Esc to stop note input, select bars 1-2 on the top staff (including
the quarter note rest), then press R to repeat the material directly after itself.

9. Press Esc or Return to stop note input.

RESULT
You have input all the notes required in the first four bars for the top staff.

I
|

[ 10

| — Il

s

——
—

N
[ 1
QL
S
QL

D)

Piano

TIP

You can also input notes by clicking on staves when the caret is active and Select [§ in the Notes
toolbox is deactivated, or by playing them on a connected MIDI keyboard.

AFTER COMPLETING THIS TASK

Continue inputting notes on the top staff using what you have learned in this task up until the
end of bar eight. To input the low F at the start of bar 7 after the high F at the end of bar 6, press
Ctrl-Alt-F (Windows) or Ctrl-F (macOS). If you input a higher F instead, press Ctrl/Cmd-Alt/
Opt-Down Arrow to transpose it down an octave.

Changing the beam grouping will be covered in a later task.

Inputting the chords on the bottom staff

Inputting notes on top of each other to create chords is very similar to inputting notes in
sequence (in that the caret must be active), but the input behavior is slightly different.

PROCEDURE

1. Inbar 1, select the rest on the bottom staff.
2. Press Shift-N to start note input.

3. Press Q to start chord input.

e Chord input allows you to input multiple notes at the same position; that is, the caret
position. In chord input, a + sign appears at the top of the caret.

L
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e You can also start chord input by clicking Chords Bl in the Notes toolbox on the left of
the window.
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e Asinthe previous task, the default note duration of a quarter note (crotchet) is selected

in the Notes panel. In this piece, the chords in the first few bars are all quarter notes, so
you don't need to change the duration.

4. Press A toinputan Ab.
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e Because this is the first pitch on the staff, Dorico uses the default pitch of the clef to
determine the register, and therefore chooses the Ab closest to the F at the center of the
bass clef. However, this piece requires the Ab below.

5. Press Ctrl/Cmd-Alt/Opt-Down Arrow to transpose the selected Ab down an octave.
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e Alt/Opt-Down Arrow transposes notes down by staff position; that is, by step. Adding
Ctrl/Cmd transposes notes down a larger amount; that is, by octave.

6. Press E toinputan Eb.

e In chord input, Dorico adds new notes above the previous note by default.
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7. Press Space to advance the caret.

e In chord input, the caret does not advance automatically, allowing you to build notes

into chords at a single rhythmic position. Dorico expects chord input to continue until
you stop it.

e Because the note duration currently selected is a quarter note, pressing Space
advances the caret forward a quarter note.
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e Now that Dorico has the first chord for pitch reference, the next Ab would be input in the
same octave as the first chord by default, which is not what the piece requires.

8. Press Shift-Alt/Opt-A to input the Ab above the note at the bottom of the previous chord,
then press C then E to input the corresponding pitches as a chord above the Ab.

19



Writing music

Inputting the chords on the bottom staff

10.

11.
12.

13.
14.
15.
16.
17.
18.
19.

20.
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e Dorico automatically selects notes the smallest interval away from the previous note.
Pressing Shift-Alt/Opt as well as the letter for the note inputs that note above the
previous note, regardless of the interval. For a lower note, it's Ctrl-Alt (Windows) or
Ctrl (macOS) plus the letter for the note. If you're not sure whether you need to specify
the register, you can always transpose notes up/down octaves after inputting them.

Press Space to advance the caret.

Press A, then C, then E to input the corresponding pitches as a chord.
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e The next bar is very similar to the first bar. However, it starts with the lower Ab again.
Press Space to advance the caret.

Press Ctrl-Alt-A (Windows) or Ctrl-A (macOS) to input the Ab below the note at the bottom
of the previous chord, then press E to input an Eb above the Ab.

Press Space to advance the caret.

Press B to input a Bb, then Ctrl/Cmd-Alt/Opt-Up Arrow to transpose the Bb up an octave.
Press D, then E to input the corresponding pitches above the Bb.

Press Space to advance the caret.

Press B, then D, then E.

Press Space to advance the caret.

Repeat steps 4 to 17 to input bars 3-4.

TIP

Alternatively, you can press Esc to stop note input, select bars 1-2 on the bottom staff, then
press R to repeat the material directly after itself.

Press Esc or Return to stop note input.

RESULT
You have input all the chords required in the first four bars for the bottom staff.
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AFTER COMPLETING THIS TASK

Continue inputting chords on the bottom staff up until beat 1 in bar 6, as accidentals are
required on beat 2 in bar 6.

Adding accidentals

So far, all the notes you have input have followed the accidentals in the key signature of Ab major.
However, the chords in bar 6 include Bj and D, so you need to add accidentals.

PREREQUISITE

On the Note Input and Editing page in Preferences (key command Ctrl/Cmd-,), you have
chosen Before inputting note for Specify accidental, rhythm dot and articulations.

PROCEDURE
1. Inbar 6, select the quarter note rest on beat 2 on the bottom staff.
2. Press Shift-N to start note input.
3. Ifchord inputis not already active, press Q to start chord input.
6
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e TheF at the bottom of the chord does not need an accidental, but following on from the
previous chord, the default register of the next F you input is a third below the Ab on
beat 1, rather than the sixth above that is required here.
4. Press Shift-Alt/Opt-F to input an F in the correct, higher octave.
e The next two pitches both require a natural accidental, so you need to prepare the
accidental before inputting each note.
5. Press 0 to select a natural accidental.
e You must press 0 on your computer keyboard, not a numeric keypad.
e You can also select a natural accidental by clicking Natural in the Notes panel on the left
of the window.
6. Press B toinputa B
? I | }
Pno
e Accidentals only apply to one note. You must reselect a natural accidental for the Db.
7. Press 0 to select a natural accidental.
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8. Press D toinputa Dh
9. Press Space to advance the caret.
10. Press F, then B, then D to input the corresponding pitches.

e Because accidentals last for the rest of the bar by default, the next B and D are also input
as Brand D automatically.

11. Press Esc or Return to stop note input.

RESULT

You have input chords each containing two notes with natural accidentals. The natural
accidentals are automatically hidden on the second chord because the default accidental
duration rule in Dorico is common practice, where accidentals apply until the end of the bar.
Similarly, the Bb in bar 7 on the top staff shows a cautionary flat accidental automatically.

e You can also add accidentals to selected notes outside of note input. Sometimes this is more
helpful, as you can add the same accidental to multiple notes at once.

For a flat accidental, press -. For a sharp accidental, press =. On an English keyboard, these
keys have - (minus) and + (plus) on them respectively, which might help you remember them:
minus lowers notes while plus raises notes. 0 for natural represents no alteration.

You can find more accidentals in the Key Signatures, Tonality Systems, and Accidentals panel
on the right of the window, which you can show by clicking Panels [, then Key Signatures,
Tonality Systems, and Accidentals | in the Notations toolbox.

e For more information about accidental duration rules, see the Operation Manual. In Dorico
SE, you cannot change the accidental duration rule.

AFTER COMPLETING THIS TASK

Continue inputting chords on the bottom staff using what you have learned in this task and the
previous task, up to and including the first beat of bar 14, without the arpeggio signs: you will
add those in a later task.

Adding another voice to the top staff

In bar 9, a second voice appears on the top staff, so you need to add an additional voice to the
staff. We will also explain how you can identify the voice into which you are inputting notes.

PROCEDURE
1. Inbar9, select the rest on the top staff.
2. Press Shift-N to start note input.

e Beside the caret, there is a note symbol. This indicates the voice to which anything you
then input is assigned by showing its stem direction, number, and type (normal, slash, or
grace).
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e Currently, the note symbol shows you are inputting notes into the first up-stem voice on
the staff, but this bar requires a down-stem voice.

3. Ifchord inputis active, press Q to stop chord input.

4. Press Shift-V to create a new voice.

e A +sign appears beside the note symbol, whose stem now points down. This indicates a
new down-stem voice.

Pno

5. Press 7 to select half notes (minims), then . (period) to add a rhythm dot, making the
duration dotted half notes.

6. Press B toinput a Bbin the new down-stem voice.

Pno

e Dorico shows a cautionary b accidental on the B due to the Bfs on the bottom staff in the
previous bar.

e The caret automatically advances to the next bar. However, in this instance, there are
still other notes in the up-stem voice in bar 9 that you need to input.

7. Press Left Arrow until the caret is positioned at the start of the second beat in bar 9.

e When moving the caret using the arrow keys, how far it moves depends on the current
rhythmic grid resolution (rather than the note duration selected in the Notes panel when
you press Space). The current rhythmic grid resolution is shown in the status bar
at the bottom of the window. By default, it's set to eighth notes.

e The note symbol beside the caret indicates that it's still set to the down-stem voice, but
the eighth notes in bar 9 are in the up-stem voice.

8. Press V to switch to the up-stem voice.
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10.

11.
12.
13.

14.
15.

16.

e V cycles through all active voices on the staff. As there are currently only two voices on
the top staff, pressing V switches between the up-stem and down-stem voices.

Press 5 to select eighth notes (quavers).

Press E, G, F, then E to input the pitches Eb, G, F, and Eb as eighth notes into the up-stem
voice.

Pno
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Press 7 then . (period) to select dotted half notes (dotted minims).

Press Q to start chord input.

Press Ctrl-Alt-A (Windows) or Ctrl-A (macOS) to input the Ab a fifth below, rather than a
fourth above, the preceding Eb, then D to input the Db above as a dotted half note chord into
the up-stem voice.

Pno

At the start of bar 11, press V to switch to the down-stem voice.

Repeat steps 5 to 13 to input bars 11-12.
TIP

Alternatively, you can press Esc to stop note input, select bars 9-10 on the top staff, then
press R to repeat the material directly after itself.

Press Esc or Return to stop note input.

RESULT

You have added a new down-stem voice and input all the notes required in bars 9-12 for the
top staff. The order in which you input notes for each voice doesn’t matter: Dorico automatically
updates stem directions and voice columns to accommodate voices.

Pno
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AFTER COMPLETING THIS TASK

Input the notes in bar 13 on the top staff using what you have learned in this task, or copy them
from bar 11.
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Adding slurs

Most phrases in this piece have slurs. This task starts by adding slurs to the phrases you have
already input, then describes inputting a slur alongside new notes.

PROCEDURE
1. Inbar 1, click anywhere on the eighth note beam on the top staff to select all notes in the
beam.
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2. Press S to add a slur across the selected notes.
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e You can also add slurs by clicking Slur in the Notes panel on the left of the window.

Piano

3. Repeatsteps 1 and 2 for each phrase that requires a slur, up to the end of bar 8.

e The slur across bars 9-10 joins notes in different voices, so you have to select these
notes differently.

4. In bar 9, select the down-stem note.

5. Ctrl/Cmd -click at least one note in bar 10 on the top staff.
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10.
11.
12.
13.
14.
15.

16.
17.
18.

19.

20.

21.
22.

e If you have Dorico Pro or Dorico Elements, in a later task you can flip these slurs and
adjust their shape, so they start on the rests.

e Thisis as far as you have input notes, so now you can input notes and slurs together.
Select the rest in bar 14 on the top staff.

Press Shift-N to start note input.

If the note symbol beside the caret is down-stem, press V to switch to the up-stem voice.
If chord input is active, press Q to stop chord input.

Press 5 to select eighth notes (quavers).

Press S to start a slur.

Input the notes under the first slur, up to the first eighth note (quaver) in bar 17.

Press Shift-S to stop the slur without stopping note input.
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Press F to input the F at the start of the next phrase.
Press S to start another slur on the currently selected note; that is, the F you just input.

Input the notes under the second slur, up to the end of bar 17.
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Press 7 to select half notes, then . (period) to add a rhythm dot, making the duration dotted
half notes.

Press G.
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Press Shift-S to stop the slur.

Press Esc or Return to stop note input.

RESULT

You have added slurs to existing phrases, including cross-voice slurs, and input slurs alongside
inputting notes.

AFTER COMPLETING THIS TASK
You can copy the music on both staves in bars 3-4 into bars 19-20.
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Inputting a tie

There is a tie that joins two notes on the bottom staff across the barline between bars 14 and 15.
In these steps you will input that tie.

PROCEDURE
1. Inbar 14, select the quarter note (crotchet) rest on beat 3 on the bottom staff.
2. Press Shift-N to start note input.

3. If chord inputis not already active, press Q to start chord input.

Pno

4. Press 7 to select half notes (minims).

e We do mean half notes, despite the caret being at the last quarter note in the bar.

5. Press D to input a half note Db.
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e Ta-dah! The half note Db automatically appears as two tied quarter notes.

6. Press Ctrl/Cmd-Alt/Opt-Up Arrow to transpose it up an octave.
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7. Press 6 to select quarter notes (crotchets).
8. Press F, then Space to advance the caret.

9. Press - to select a flat accidental, then F to input an Fb.
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10. Press Esc or Return to stop note input.
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RESULT

You have input a half note (minim) that is displayed as two tied quarter notes (crotchets). Dorico
treats it as a single note, meaning if you click either notehead, both are selected.

TIP

In Dorico, in most cases you don't need to input ties: simply select the total duration of the note,
and Dorico splits it up into tied notes as appropriate for the time signature and its position in the
bar. This applies to beam grouping as well as note grouping. If you do need to tie notes together
manually, the key command is T; to remove ties, the key command is U.

In Write mode, you can only select whole tie chains because Dorico considers each tie chain to be
a single note. However, you can still input notations, such as dynamics, in the middle of tie chains
by activating the caret and moving it to the required rhythmic position within the tie chain.

AFTER COMPLETING THIS TASK

You can input the rest of the notes on the bottom staff up to the end of bar 18. We recommend
inputting the E* at the end of bar 15 as a Dk you will learn how to respell notes in a later task.

Adding dynamics

This piece includes a number of different dynamics, including ones such as mp, which are known
as “immediate dynamics” in Dorico, and crescendo/diminuendo hairpins, which we collectively
name “gradual dynamics”. Like slurs, you can add dynamics to existing music as well as inputting
them during note input.

You can also input a slur during this task by starting the slur after step 13 and ending it between
inputting the two Fs in step 17.

PROCEDURE
1. Inbar 1, select the quarter note rest on the top staff.
2. Press Shift-D to open the dynamics popover.

3. Enter mp into the popover.
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4. Press Return to close the popover and input the mp dynamic.
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5. Inbar5, click the eighth note G on the top staff.

6. Press < (thatis, Shift-,)to input a crescendo hairpin that spans the selected note; that is,

an eighth note in duration.
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10.
1.
12.

13.

14.

e Dorico uses the < and > characters for crescendo and diminuendo hairpins respectively,
due to their similar appearance.
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e This hairpin should actually be longer, so you need to lengthen it.

Press Shift-Alt/Opt-Right Arrow to lengthen the hairpin up to beat 2 in bar 6.

e The number of presses required depends on your rhythmic grid resolution Il

il

Pno

TIP

e You can also shorten hairpins by pressing Shift-Alt/Opt-Left Arrow . These key
commands apply to notes too, as well as all notations with duration, such as pedal lines,
slurs, and gradual tempo changes.

e Ifyou select a range of notes and then input a gradual dynamic, it spans the selection
automatically.

e Now you can try inputting notes and dynamics at the same time.

In bar 21, select the bar rest on the top staff.

Press Shift-N to start note input.

If chord input is active, press Q to stop chord input.

Press 5 to select eighth notes (quavers).

Press Space to advance the caret one eighth note, then press F to input an F.

e Ifyou have not already input the phrase in bars 19-20, the F might be input in the wrong
octave. You can either press Ctrl-Alt-F (Windows) or Ctrl-F (macOS) to specify the
lower octave before you input it, or press Ctrl/Cmd-Alt/Opt-Down Arrow to transpose
it down an octave after inputting it.

Press < (thatis, Shift-,) to start a crescendo hairpin.

e The hairpin is not visible yet, as it has no duration until you have advanced the caret. It
will appear and extend as you input notes.

Press G, A, B, C, D, then E to input the corresponding pitches.

e The hairpin extends as you input notes. Hairpins also extend when you press Space to
advance the caret.
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15.
16.
17.
18.
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Press ? (thatis, Shift-/) to stop the hairpin.
Press 6 to select quarter notes (crotchets).
Press F twice to input two quarter note Fs.

Press Esc or Return to stop note input.

RESULT

You have added immediate and gradual dynamics to existing notes, and input gradual dynamics
alongside inputting notes.

TIP

You can also add dynamics using the Dynamics panel on the right of the window, which you can
show by clicking Panels [, then Dynamics [ in the Notations toolbox.

Adding articulations

This piece includes a number of different articulations, including marcato, tenuto, and staccato
marks. You can add articulations to existing notes as well as inputting them alongside notes.

PROCEDURE
1. Ctrl/Cmd -click the Gs in bars 2, 4, 18, and 20 on the top staff.
2. Press ' to add marcatos to all selected notes.
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e You can also select articulations by clicking the corresponding button in the Notes panel
on the left of the window. The key commands for articulations use the four keys to
the left of the Return key on the computer keyboard, matching their arrangement in
the Notes panel. Combining Shift with these keys allows you to access the lower four
articulations in the panel.
3. Ctrl/Cmd -click the quarter note Fs on beat 3 in bars 6, 8, and 22.
4. Press ] to add staccatos to all selected notes.
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10.
1.

12.

13.

14.
15.

e Now you can try inputting notes and articulations at the same time. The next articulation
you need to input is at the end of bar 24, and because the phrase in bars 23-24 is the

same as 21-22, you can copy most of it.
In bar 21, select the eighth note rest on the top staff.

Shift-click the F on beat 2 in bar 22 on the top staff to select everything on the top staff up
to that note.

1]
-

Alt/Opt -click the top staff at the start of bar 23.

e This copies the selected material to the closest position to the mouse pointer, as

determined by the rhythmic grid resolution, without copying it to your clipboard. If your
rhythmic grid resolution is very small, such as 32nd notes, you must be more precise
where you Alt/Opt-click than if it's set to a larger value, such as quarter notes.

In bar 24, select the quarter note rest on beat 3 on the top staff.
Press Shift-N to start note input.
Press ] to select staccatos.

Press F to input an F with a staccato.
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e Articulations are sticky in Dorico, which means all notes you input have the selected

articulations until you deactivate them or stop note input. This is different to accidentals,
where the selected accidental only applies to the next note you input.

Press ] again to deactivate staccatos.

e The next steps skip ahead in the piece to demonstrate inputting consecutive notes with

tenuto marks.

Press Ctrl/Cmd-Right Arrow to move the caret to the next bar for each press until it
reaches the start of bar 39.

Press # (Windows) or \ (macOS) to select tenutos.

Press D, F, then B to input the corresponding pitches with tenuto articulations.
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e There are also three quarter notes with tenuto marks on the bottom staff in this bar, so

you need to move the caret back to input those notes too.
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16. Press Ctrl/Cmd-Left Arrow to move the caret back a bar to the start of bar 39.

17. Press Down Arrow to move the caret to the bottom staff.
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18. Press 0 to select a natural accidental, then G, F, then E to input the corresponding pitches
with tenuto articulations.
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19. Press Esc or Return to stop note input.

RESULT

You have added articulations to existing notes and input notes with articulations.

Adding arpeggio signs to chords

Most of the chords in this piece are played straight, but a number are rolled, which is indicated

with an arpeggio sign. You can add arpeggio signs to existing chords as well as inputting them
alongside inputting notes.

PREREQUISITE
You have input all the chords on the bottom staff, up to and including the first beat of bar 14.

PROCEDURE

1. Inbar9, click the stem of the chord on beat 1 on the bottom staff to select all notes in the
chord.

e Arpeggio signs apply automatically to all notes in the voice, so you can even select just a
single note in the chord.

e You can only add arpeggio signs to a single chord at a time.
2. Press Shift-O to open the ornaments popover.

3. Enter arp into the popover.

Pno

4. Press Return to close the popover and input an arpeggio sign across all notes in the
selected chord.
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5. Repeatsteps 1 to 4 for the chords on beat 1 in bars 11, 13, and 14.
e Now you can try inputting an arpeggio sign alongside a chord.
6. Inbar 26, select the bar rest on the top staff.
7. Press Shift-N to start note input.
8. If chord inputis not already active, press Q to start chord input.
9. Press Shift-O to open the ornaments popover.
10. Enter arp into the popover.
11. Press Return to close the popover and input an arpeggio sign at the rhythmic position of
the caret.
12. Press A toinput an Ab.
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e When you input the Ab, a short arpeggio sign appears to the left of the note.
e Based on the previous pitches in this voice on the staff, Dorico inputs the Ab at the top of
the chord.
13. Press Ctrl-Alt-E (Windows) or Ctrl-E (macOS), then Ctrl-Alt-A (Windows) or Ctrl-
A (mac0S) to input the corresponding pitches below the top Ab.
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e When you input the Eb then another Ab below, the arpeggio automatically extends across
all three notes.
14. Press Esc or Return to stop note input.
RESULT

You have added arpeggio signs to existing chords and input an arpeggio sign alongside
inputting a new chord.

TIP

You can also add arpeggio signs using the Ornaments panel on the right of the window, which
you can show by clicking Panels g, then Ornaments [ in the Notations toolbox.
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Adding tempo marks

Because this piece was composed in the Romantic era, it includes a fair amount of rubato. This is
indicated in the music with relatively short fluctuations in tempo, including a ritardando followed
by an a tempo, which you will input in this task.

Now that you have completed several tasks, you have probably correctly worked out that you can
input tempo marks both during note input and by adding them to existing music. During note
input, they are input at the caret position. However, gradual tempo changes, such as accelerando,
do not extend as you input notes.

PROCEDURE
1. Inbar 11, select any note on beat 2.

e Because tempo marks are system objects and apply to all systems in a layout, you can
select notes on either staff that span the required duration.

2. Ctrl/Cmd -click the chord on beat 3 in bar 12.
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3. Press Shift-T to open the tempo popover.

4. Enter poco rit. into the popover.
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5. Press Return to close the popover and input a poco rit. gradual tempo change that spans
the selected range.

e A continuation line is automatically shown for its duration. The circular handles at the
start and end control its rhythmic start and end positions.
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6. Inbar 13, select any of the notes or the rest on beat 1.
7. Press Shift-T to open the tempo popover.

8. Enter a tempo into the popover.
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RESULT

You have added a gradual tempo change and an absolute tempo change. Dorico automatically
aligns the ritardando continuation line with the “A tempo” marking.

TIP

You can also add tempo marks using the Tempo panel on the right of the window, which you can
show by clicking Panels [, then Tempo [ in the Notations toolbox.

AFTER COMPLETING THIS TASK

Using the tempo popover (Shift-T), input a Grazioso tempo mark at the start of bar 1. If you
input the version with a suggested metronome mark, you can hide the metronome mark by
selecting it and deactivating Metronome mark in the Tempo group of the Properties panel in
the lower zone (press Ctrl/Cmd-8 to hide/show it).

Dorico aligns the Grazioso tempo mark with the time signature automatically.

Adding clef changes

In this piece, the register on the staff changes drastically enough in some places to justify a
change in clef. The first clef changes are at the end of the first section of the piece.

PROCEDURE

In bar 28, select the rest on the top staff.

Press Shift-N to start note input.

If chord input is not already active, press Q to start chord input.

Press F, C, then F to input the corresponding pitches as a quarter note chord.
Press Space to advance the caret.

Press Shift-C to open the clefs and octave lines popover.

N o un s wNhN=

Enter bass into the popover.

35



Writing music
Adding clef changes

‘I bass|
28

L4

a,nr
1
1

Pno

N
P
R
T
1
1
1

8. Press Return to close the popover and input a bass clef at the caret position.
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9. Continue inputting notes and chords on the top staff until the end of bar 29.
e To select flat accidentals for each Fb on beat 3 in bar 28, press -.

e When you add a chord in the down-stem voice on beat 3 in bar 29, rests appear on beats
1 and 2. In the next task, you can delete them.

10. Press Esc or Return to stop note input.
11. In bar 30, select the rest on the top staff.
12. Press Shift-C to open the clefs and octave lines popover.

13. Enter treble into the popover.
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14. Press Return to close the popover and input a treble clef at the selected rhythmic position.
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RESULT

You have input two clef changes plus the notes and chords required on the top staff in bars
28-29.
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TIP

When adding clefs at the start of a selected range of existing music, Dorico automatically
adds a restorative clef at the end of the range.

You can also add clefs using the Clefs panel on the right of the window, which you can show
by clicking Panels [, then Clefs [ in the Notations toolbox.

Deleting rests

Dorico automatically shows rests between the notes you input, as appropriate for the prevailing
time signature and their position in the bar. When using voices to notate passing notes, as in bar

29, rests in those voices are not always wanted. In such cases, you can delete rests.
PROCEDURE
1. Inbar 29, click on the staff to select all items in the bar.
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Choose Edit > Remove Rests.

RESULT

All rests within the selection are removed. This is done by automatically activating the Starts
voice and Ends voice properties in the Notes and Rests group of the Properties panel on the
required notes so that no rests are shown in the selected region.

Pno

Inputting tuplets

In bars 30-40, there are several different tuplets that you must input. Dorico allows you to input
tuplets with any ratio, including over barlines.

PROCEDURE

1.

2
3
4.
5

In bar 30, select the rest on the top staff.

Press Shift-N to start note input.

If chord input is active, press Q to stop chord input.
Press ; to open the tuplets popover.

Enter 5:4x into the popover.
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10.
11.
12.

5:4x
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e Tuplets are expressed as ratios: the number of notes in the tuplet, followed by the
number of normal notes the tuplet lasts for, separated by a colon. For example, 5:4
means five notes in the space of four (a quintuplet), 3:2 means three notes in the space
of two (a triplet). The letter after the ratio specifies the beat unit. For example, x for
16th notes, e for eighth notes, q for quarter notes. If you don't specify the beat unit in
your popover entry, the tuplet is based on the note value currently selected in the Notes
panel.

Press Return to close the popover and input a 16th note (semiquaver) quintuplet.
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Press 4 to select 16th notes (semiquavers).

e You can input notes of any duration inside tuplets of any ratio. If the note is too long to
fit, any extra duration is notated beyond the tuplet.

Press F, D, Ctrl-Alt-G (Windows) or Ctrl-G (macOS) to input the G below, Shift-Alt/Opt-D
to input the Db above, then F.
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e Tuplets are sticky in Dorico, which means you continue to input the specified tuplet until
you stop tuplet input or note input.

e Dorico shows a cautionary b accidental on the first D due to the Dis in the previous bar.
Press : (thatis, Shift-;) to stop tuplet input.

e Shift-; stops tuplet input, Shift-S stops slurs, while Shift-/ stops gradual dynamics.
Press 6 to select quarter notes (crotchets).

Press B, then C.

Repeat steps 4 to 11 for bar 31.
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13.

14.
15.
16.
17.

18.

19.
20.

21.

22.

TIP

Alternatively, you can press Esc to stop note input, select bar 30 (without the treble clef),
press R to repeat the material directly after itself, then press Ctrl/Cmd-Alt/Opt-Up Arrow
to transpose it up an octave.

Press Esc or Return to stop note input.

Now you can try inputting consecutive triplets.

In bar 40, select the rest on the bottom staff.

Press Shift-N to start note input.

Press ; to open the tuplets popover.

Enter 3:2e, for three eighth notes in the space of two, into the popover.
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Press 5 to select eighth notes (quavers).
Press A to input an Ab.
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Based on the preceding pitches,

this inputs an Ab that is two octaves too high.

Press Ctrl/Cmd-Alt/Opt-Down Arrow twice to transpose it down to the correct octave.
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Press Shift-Alt/Opt-E to input the Eb a fifth above, rather than a fourth below, the preceding
Ab, then A, C, E, then A to input the corresponding pitches as triplet eighth notes.
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23.
24.
25.
26.
27.
28.

Press : (thatis, Shift-;) to stop tuplet input.

Press Shift-C to open the clefs and octave lines popover.

Enter treble into the popover.
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Press Return to close the popover and input a treble clef at the caret position.

Press 6 to select quarter notes (crotchets).

Press C to input a quarter note C.

29. Press Esc or Return to stop note input.
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RESULT

You have input two different types of tuplets and an additional clef change. In a later task, you
can change the direction of stems in bars 30-31.

Adding a grace note

In bar 32, there is a grace note before a chord on the top staff. In this task, you will input the

chords on the top staff in bar 32 including the grace note.

Press Ctrl-Alt-C (Windows) or Ctrl-C (macOS), E, then A to input the chord.

PROCEDURE
1. Inbar 32, select the rest on the top staff.
2. Press Shift-N to start note input.
3. Ifchord inputis not already active, press Q to start chord input.
4
5. Press Space to advance the caret.
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6. Press / to start grace note input.

In grace note input, the caret appears a bit shorter than in standard note input.
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e You can also activate grace note input by clicking Grace Notes [ in the Notes toolbox
on the left of the window.

7. Press 5 to select eighth notes (quavers).
8. Press B toinput a Bb grace note.

9. Press Ctrl/Cmd-Alt/Opt-Up Arrow twice to transpose it up two octaves.
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10. Press / to stop grace note input.
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e The caret gets larger and appears to advance a little as it returns to normal note
position. It had stayed at the grace note position because chord input was active.

11. Press 7 to select half notes (minims).

12. Press Ctrl-Alt-C (Windows) or Ctrl-C (macOS), E, then A.
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13. Press Esc or Return to stop note input.

RESULT

You have input a grace note alongside the required chords on the top staff in bar 32.
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Adding an octave line

To avoid having lots of ledger lines, the chord you input in bar 32 that jumps up an octave can be
notated with an 8va octave line; that is, an octave line that indicates notes are played an octave
higher than written.

PROCEDURE
1. Inbar 32, click the grace note on the top staff, then Shift-click the chord on beat 2.
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2. Press Shift-C to open the clefs and octave lines popover.

3. Enter 8va into the popover.

Pno

4. Press Return to close the popover.

RESULT

An 8va octave line that spans the grace note and chord is input. All notes within the span of the
octave line are automatically notated an octave lower than before you input the octave line.
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The octave line's endpoint is attached to the start of the next bar, as indicated by the dotted
red line, but its continuation line ends to the right of the chord. This follows conventions for the
length and placement of octave lines.

TIP

You can also add octave lines using the Clefs panel on the right of the window, which you can
show by clicking Panels [, then Clefs 8 in the Notations toolbox. They share a panel with clefs
as both notations alter where notes appear on staves.
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Inputting the music in bars 33-35

Bars 33-35 include cross-staff beams (beams that start on the bottom staff but end on the top
staff) and chords with alternative note spellings. In this task, you will input all the notes and
chords required in these bars; in the next two tasks, you will cross notes from the bottom staff to
the top staff and respell notes to show the Bs.

PROCEDURE

® N o v kA W N2

10.
1.
12.

13.
14.
15.

16.

In bar 33, select the rest on the bottom staff.

Press Shift-N to start note input.

If chord input is active, press Q to stop chord input.

Press ; to open the tuplets popover.

Enter 3:2x into the popover.

Press Return to close the popover and input a 16th note triplet.
Press 4 to select 16th notes (semiquavers).

Press D to input a Db, then Ctrl/Cmd-Alt/Opt-Down Arrow twice to transpose it down two
octaves.

Press Shift-Alt/Opt-A to input the Ab a fifth above, rather than a fourth below, the preceding
Db, then D to input the Db a fourth above that.
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Press : (thatis, Shift-;) to stop tuplet input.

Press 3 to select 32nd notes (demisemiquavers).

Press F, A, D, then F to input the corresponding pitches.
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Press 6, then A to input a quarter note Ab.

Press Q to start chord input.

Press Ctrl-Alt-D (Windows) or Ctrl-D (macOS) to input a Db a fifth below, rather than a
fourth above, the previous Ab, then 0, E, 0, G, 0, then A.

e Thisinputs the chord on beat 3 with the required natural accidentals. You will respell the
Ayinto a B¥ later.

Press Up Arrow to move the caret to the top staff.
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17. Press ', 0, then Ctrl-Alt-E (Windows) or Ctrl-E (macOS).

e This selects the marcato articulation, natural accidental, and inputs an Ej a sixth below,

rather than a third above, the preceding note on the top staff (that is, the C at the
bottom of the chord in bar 32).

18. Press Esc or Return to stop note input.

e Bar 33 should now look like this:
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20. Select everything in bars 33-35, then choose Edit > Remove Rests.

e A quick way of selecting everything in bars 33-35 is to click on the bottom staff in bar 33,

but not on the notes, then Shift-click on the top staff in bar 35, also not on the notes.
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RESULT

You have input the notes and chords required for bars 33-35 and removed the rests. Removing
rests was necessary here because the chords will behave as if they were in a down-stem voice
when you cross them to the top staff. When cross-staff music only involves a single voice,
removing rests is not necessary: Dorico hides them as required automatically.
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Crossing notes to the other staff

In Dorico, you can achieve cross-staff beams for phrases that span multiple staves by inputting
all the notes on one staff and then crossing some to the other. In the previous task, you input the
notes so now you can cross them.

PROCEDURE
1. Inbar 35, select the A} at the top of the chord on beat 3.
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e The Alis merged into the up-stem voice with the existing Ek.

3. Inbar 33, select the 32nd note (demisemiquaver) Db, then Shift -click the chord on beat 3.
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4. Press N to cross the selected notes to the staff above.
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5. Repeat steps 3 to 4 for bars 34-35.
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RESULT

The notes are crossed from the bottom staff to the top staff with centered cross-staff beams
and appropriate stem directions automatically. Notes crossed to other staves still belong to their
home staff, but appear on the other.

TIP

e The key commands for moving notes to other staves use the same keys as crossing notes
to other staves, plus the Alt/Opt key: moving notes to the staff above (Alt/Opt-N) and
crossing notes to the staff above (N) both involve upwards movement, while moving notes
to the staff below (Alt/Opt-M ) and crossing notes to the staff below (M) both involve
downwards movement.

e You could also Ctrl/Cmd -click the relevant notes in bars 33-35 and cross them all to the staff
above together, but this can be slower than separate Shift -clicked selections.

Respelling notes

In bars 33-34, you input Abs that were notated as B¥s in the original edition, and a Db in bar 35
that was originally notated as a C#. You may also have input a Djin bar 15 that was originally
notated as an E®. In this task, you can respell these notes.

PROCEDURE
1. Inbars 33 and 34, select the Ats in the down-stem chord on beat 3.
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4. Press Alt/Opt-- to respell it using the note below and notate it as Ct.
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5. Inbar 15, select the Dk on beat 3 on the bass staff.

6. Press Alt/Opt-= to respell it using the note above and notate it as an E*.

RESULT

The Abs and Dt are respelled upwards, and the Db is respelled downwards.
TIP

e The key commands for respelling notes use the same keys as adding accidentals, plus the
Alt/Opt key: respelling upwards (Alt/Opt-=) and sharp accidentals (=) both involve raising

notes, while respelling downwards (Alt/Opt--) and flat accidentals (-) both involve lowering
notes.

e You can find more accidentals than b, b, or §in the Key Signatures, Tonality Systems, and
Accidentals panel on the right of the window, which you can show by clicking Panels EJ, then
Key Signatures, Tonality Systems, and Accidentals [f] in the Notations toolbox.

So instead of inputting an A then respelling it, you could input a B* straightaway.

Adding indications for left/right hands

To clarify which hand should play notes when they are notated on the same staff, the original

edition has “l.H.” and “r.H."” indications, for “left hand” and “right hand” respectively, above and
below the staff.

PROCEDURE
1. Inbar 30, select the Bb on beat 2 on the top staff.
2. Press Shift-X to add staff-attached text and open the text editor.

e You can also add staff-attached text by clicking Popovers B, then Text | in the
Notations toolbox. To open the text editor for an existing text item, select it and press

Return.
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3. Enter l.H..

4. Select the “I.H." text in the text editor, then select the Italic font style from the editor options.
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5. Press Esc or Ctrl/Cmd-Return to close the text editor.

6. Selectthe “l.H.” text, then press F to flip it below the staff.
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7. Repeatsteps 1to 5 for the “r.H.” indication, but in step 1, select the C on beat 3.
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Ctrl/Cmd -click both text items, then Alt/Opt -click the staff on beat 2 in bar 31 to copy them
at that position.
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RESULT

You have added text items that indicate the left and right hands, formatted the text as italics, and
flipped the “I.H.” indication below the staff.
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Adding the repeat ending

Repeat ending structures in Dorico automatically incorporate the lines above the staff and the

repeat barline. In the original edition, the second ending has a closed hook end, so you can also
replicate that.

PROCEDURE
1. Inbar 39, select any note on the first beat.

2. Shift-click anything that lasts until the end of bar 40, such as the note on beat 3 on the
bottom staff or the bar rest on the top staff.
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3. Press Shift-R to open the repeats popover.
4. Enter end or ending into the popover.
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5. Press Return to close the popover and input a repeat ending where the first ending spans

the duration of your selections, and the second ending lasts one bar.
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6. Select the repeat ending, then press Shift-Alt/Opt-Right Arrow to lengthen the second

ending so it lasts two bars.
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In the Properties panel in the lower zone, activate End of line in the Repeat Endings group
and select Closed from the menu to give the line a hook end.
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Finish writing the music

e Ifyou can't see the Properties panel, press Ctrl/Cmd-8 to show the lower zone, then
select Properties [g in the lower zone toolbar.
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RESULT

You have added the repeat ending, lengthened the duration of the second ending, and changed
its end so the second ending has a hook. Dorico inputs a repeat barline at the end of the first
ending automatically.

Finish writing the music

You should now have input a decent portion of the whole piece, and by following the previous
tasks, learned how to do everything required to complete Dora Pejacevic's “Walzer-Capricen
No. 2".

Now you can finish inputting the full piece by referring to the complete score (available on
steinberg.help). Here are some reminders and tips to help you finish:

The music from bar 43 to the end is almost an exact repetition of bars 1-32. If you first
finish everything required in bars 1-32, you can simply copy that to bar 43 and check for any
differences, tweaking the duplicated material as required.

NOTE

In the original edition, the clef changes in bars 28-30 were not included when material
returns in bars 70-72, presumably to save horizontal space in that system. You can decide for
yourself whether to include the clef changes the second time!

There are many more dynamics and slurs in the piece than were included in these steps, so
you can add the rest of those.

If you input anything in the wrong place or voice, you can easily move and lengthen/shorten
notes and items:

e To move notes/items rhythmically to the right, press Alt/Opt-Right Arrow. To move
them to the left, press Alt/Opt-Left Arrow . (These key commands move dynamics to
noteheads. To move dynamics by the rhythmic grid instead, press Ctrl/Cmd-Alt/Opt-
Right Arrow or Ctrl/Cmd-Alt/Opt-Left Arrow .)

e Tolengthen notes and items with duration, like hairpins, press Shift-Alt/Opt-
Right Arrow . To shorten them, press Shift-Alt/Opt-Left Arrow .

e To move notes/items to the staff above, press Alt/Opt-N. To move notes/items to the
staff below, press Alt/Opt-M.

e To change the voice of notes, such as from an up-stem voice to a down-stem voice,
select the notes and choose Edit > Voices > Change Voice > [Voice]. You can also
choose this option from the context menu.

e Toflip items so they appear on the other side of the staff, press F.
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Writing music

Finish writing the music

Likewise, you can specify the register of notes before inputting them and change their pitch
after inputting them:

e Toinput a note above the previous note, press Shift-Alt/Opt plus the letter for the
note; for example, Shift-Alt/Opt-A. To input a note below the previous note, press
Ctrl-Alt (Windows) or Ctrl (macOS) plus the letter for the note; for example, Ctrl-Alt-
A (Windows) or Ctrl-A (macOS).

e To raise notes by staff position, such as C to D, press Alt/Opt-Up Arrow . To lower notes
by staff position, such as D to C, press Alt/Opt-Down Arrow .

e Toraise notes by octave divisions, press Shift-Alt/Opt-Up Arrow . To lower notes
by octave divisions, press Shift-Alt/Opt-Down Arrow . (The amount depends on the
prevailing tonality system: half-steps (semitones) in 12-EDO or quarter tones in 24-EDO.)

e To raise notes an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow . To lower notes an octave,
press Ctrl/Cmd-Alt/Opt-Down Arrow .

You shouldn’t need to input rests anywhere: just move the caret to where the notes should
be, and Dorico will show any required rests around them.

e To start note input on a specific beat, double-click the staff at that position.

e To advance the caret according to the note duration currently selected in the Notes
panel, press Space. This also extends notations with duration, such as gradual
dynamics, and continues any prevailing tuplets.

e To move the caret according to the current rhythmic grid resolution [EIRE, press
Right Arrow / Left Arrow .

e To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow.

e To move the caret to the staff above/below, press Up Arrow/Down Arrow .

e To move the caret to the top/bottom staff in the system, press Ctrl/Cmd-Up Arrow /
Ctrl/Cmd-Down Arrow .

The key commands for accidentals are - for flat, 0 for natural, and = for sharp. You don't
have to specify accidentals if they're included in the key signature.

The key commands for common note durations are 5 for eighth notes (quavers), 6 for
quarter notes (crotchets), 7 for half notes (minims), and . (period) for rhythm dots. Shorter
durations have smaller numbers, longer durations have larger numbers.

You can use the arrow keys to navigate around items in the music area, and press Tab to
switch the selection to other types of items at the same position, such as from a note to a
dynamic or slur.
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Laying out and formatting
pages

Once you have input all the notes and notations required, you can lay out and format pages to
produce practical sheet music.

The following tasks take you through the steps required for this process. You can do most of the
top-level changes in any mode and product version, but some tasks are only possible in Engrave
mode.

If you have completed all the steps in the Writing music section and finished off the piece, or
downloaded the completed but unformatted Dorico project from steinberg.help, your project
should look something like this:

Untitled Project 1
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To produce practical performance material, the following tasks will result in the piece fitting

on two pages, allowing it to fit comfortably on music stands without page turns. The tasks
demonstrate achieving this using primarily the available default options, without much tweaking
on individual pages.

TIP

e Many of the following tasks involve the Layout Options dialog, and at the end of each task
you have the option to Apply your changes and Close the dialog. However, you can apply
changes without having to close Layout Options, which is particularly useful if you have the
dialog open on a second display. You could keep the dialog open until the end of Starting on
a left-hand page, rather than closing and reopening it between tasks.

e We recommend resetting the full score layout to the factory default layout options. You can
do this in Layout Options ( Ctrl/Cmd-Shift-L ) by clicking Reset to Factory at the bottom of
the dialog.

e You could complete many of these tasks in any order, as projects follow the options you set
dynamically.

e Although this project only contains a single layout, you can use the principles covered in the
following tasks when formatting parts for larger ensembles. Options in Layout Options can
be set on a per-layout basis, meaning that, for example, you can set smaller inter-system
gaps in dense part layouts with few page turn opportunities, without affecting the spacing in
other parts or the full score. Similarly, moving items graphically in Engrave mode by default
only affects that layout.
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Laying out and formatting pages
Adding the title and composer

Adding the title and composer

You need to add title and composer information for the project. On page 1, there are two
different titles: the project title (“Untitled Project 1”, most likely) and the flow title (“Flow 1").

The project title and flow title are separate because Dorico allows you to have multiple separate
pieces of music, known as “flows”, in the same project. For example, you might have a project
called “Symphony in G" that has four movements, each a separate flow. In this project, there is
only one flow.

PROCEDURE
1. Press Ctrl/Cmd-I to open the Project Info dialog.

e You can also open the Project Info dialog by choosing File > Project Info.

Title | Untitled Project 1|

1. Flow 1

Subtitle

Dedication

Composer

Arranger

Lyricist

Artist

Copyist

Publisher

Editor

Copyright

Work number Composition year

Composer dates

Other information

Generate preview thumbnails when saving

Copyinfofrom  Flow1 v

2. With Project selected in the list on the left, in the Title field, enter Walzer-Capricen No. 2.

3. Inthe Composer field, enter Dora Pejacevic.

NOTE

Enter the accented characters directly, such as from the character map (Windows) or emoji
and symbols character viewer (macOS), rather than pasting them in.

4. Inthe list on the left, select Flow 1.

5. Atthe bottom of the dialog, make sure Project is selected for Copy info from.
6. Click Copy to copy all information from the Project to Flow 1.

7. Click Apply, then Close.

RESULT

The title and composer for both the project and flow 1 are updated.
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Laying out and formatting pages
Page templates and tokens

Because the project title and flow title are referred to in different places using tokens by default,
sometimes it is easiest to give both the project and the flow the same information in Project
Info, rather than changing the tokens used in different places.

Walzer-Capricen No. 2
Dora Pejadevi¢
1. Walzer-Capricen No. 2

Grazioso

Piano

Page templates and tokens

Although you can only edit and use page templates and tokens fully in Dorico Pro, it is worth
understanding the basic principles of how Dorico uses them to display information on pages,
regardless of your product version.

When you added information in Project Info, that information automatically appeared in the
music. This affected the following information:

1

Walzer- Capnccn No. 2

Dera
1. Walzer-Capricen No. 2
Grazioso

LE: 'IJII ¥ II'JD'
.o,-lg |IJ¢ I}o

Project title

Flow heading, displaying the number and title of Flow 1

Project composer

A W N =

Running header, displaying the title of Flow 1

The flow heading and running header both refer to the flow title, rather than the project title,
so that they can update automatically according to the nearest flow below them. If your project
contained four flows, for example, this means you could use the same page formatting on all
pages and the flow titles always refer to the relevant flow.

Dorico achieves this by using tokens that refer to fields in Project Info. Tokens automatically
populate with the corresponding information, such as flow titles or layout names. You might also
know them as “wildcards".

In Dorico Pro and Dorico Elements, the green text frames on the default page templates that
contain these tokens are shown when you switch to Engrave mode:
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Laying out and formatting pages
Hiding the flow heading

13 ‘Walzer-Capricen No. 2

Walzer-Capricen No. 2
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Page templates in Dorico allow the same page formatting to be applied to multiple different
pages and in different layouts. All pages in your scores and parts inherit their page formats from
page template. Whenever you create or change anything on page templates, this is automatically
reflected on the pages that use these page templates.

The project title and composer are both on the First page template. The running header is on the
Default page template. The flow heading is shown above the first system in the flow, inside the
music frame.

If you enter the top text frame on page 1, by either double-clicking it or selecting the edge and
pressing Return, the token that populates with the project title is shown:

v fF 200pt 100%

v [ o.o00pt
{@projectTitle@)

A| (None) v

9 Title

Regular 0.00pt

Academico v

Dora Pejacdevid

1. Walzer-Capricen No. 2

NOTE

Editing frames directly on pages in layouts creates page template overrides. If you want to
make changes to frames that come from page templates, we recommend that you edit the
page template itself. This means you only have to make the change once, and all pages that
use the page template are updated.

The information you add in Project Info only appears on pages where the corresponding
tokens exist. For example, if you want to display a dedication above the project title, you
must add the dedication token to the First page template.

The default frames on page templates use paragraph styles to format the corresponding
type of text consistently. You can edit paragraph styles in Dorico Pro by choosing Library >
Paragraph Styles.

In Dorico Pro, you can right-click inside text frames to access tokens via the context menu.

Hiding the flow heading

Because there is only a single flow in this project, you can hide the flow heading as it duplicates
the project title. If your project contained all nine pieces in Pejacevi¢'s Opus 28 “Walzer-Capricen”,
you would most likely want to show flow headings above each piece.

PROCEDURE

1.

2
3.
4

Press Ctrl/Cmd-Shift-L to open Layout Options.
In the category list, click Page Setup.
In the Flows section, choose Never for Show flow headings.

Click Apply, then Close.
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Laying out and formatting pages
Hiding staff labels

RESULT
All flow headings in the layout are hidden. However, this doesn't hide the running header at the
top of pages 2-4.

Walzer-Capricen No. 2
Dora Pejadevi¢
Grazioso
A e A —
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e
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e For projects with more than one layout, make sure you select the required layouts in the list
on the right before changing options.

e Astempting as it might be if you have Dorico Pro to switch to Engrave mode, select the flow
heading frame, and press Backspace or Delete, it is better to hide the flow heading using
this method: it doesn't produce a page template override and hides all flow headings in the
layout, meaning you don't have to delete each one.

Hiding staff labels

As this piece only contains a single piano, hiding staff labels increases the available horizontal
space for the music without losing useful information. Because it is an engraving tradition to
indent the first system in parts slightly, you will add a small first system indent too.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L to open Layout Options.

2. Inthe category list, click Staves and Systems.

3. Inthe Staff Labels section, choose None for both of the following options:
e Staff labels on first system
e Staff labels on subsequent systems

4. ForIndent first system of flow by [n] spaces, enter 6.

5. Click Apply, then Close.

RESULT

Staff labels are hidden on all systems in the layout, and the first system is indented by 6 spaces.
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Laying out and formatting pages
Changing the page size and margins
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Changing the page size and margins

The next thing you can do to increase the available space on each page for music is to change
the page margins. You can also change the page size to A4 so it's the same as in our example.

The following types of margins are relevant for this project:
e Page margins for all four edges, which control the available area for frames. Frames cannot
go beyond page margins.

e Music frame margins at the top and bottom of music frames, which control the gaps
between the top and bottom of music frames and the top and bottom staff lines. Very high
and very low notes extend into music frame margins, so in a very low cello part, for example,
you might want a larger bottom music frame margin.

TIP

e You can change your Preferred unit of measurement on the General page in Preferences
(key command Ctrl/Cmd-, ). This task uses millimeters and inches.

e You can press Tab to select the next value field in options dialogs.

PROCEDURE
1. Press Ctrl/Cmd-Shift-L to open Layout Options.
2. Inthe category list, click Page Setup.
3. Inthe Page Size section, select A4 from the Size menu.
4. Inthe Page Margins section, change the page margins:
e For Top, enter 11 mm or 0.433 inches.
e For Bottom, enter 12 mm or 0.473 inches.
e For Left, enter 14 mm or 0.551 inches.

e For Right, enter 14 mm or 0.551 inches.
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Laying out and formatting pages

Deleting the copyright text frame (Dorico Pro only)

5. Inthe Music Frame Margins section, change the music frame margins:

e For Top, enter 12 mm or 0.473 inches.

e For Bottom, enter 8 mm or 0.315 inches.

6. Click Apply, then Close.

RESULT

The margins on all pages in the layout are changed and the page size is set to A4. A combination
of this change and hiding the staff labels in the previous task causes the casting off (the
distribution of music into systems and pages) to update automatically.
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Deleting the copyright text frame (Dorico Pro only)

By default, Dorico includes a text frame for the copyright notice at the bottom of the First page
template (used for the first page of music). This piece does not require a copyright notice, so
Dorico Pro users can delete it to increase the vertical space available for music and keep the
bottom staves aligned across all pages.

PROCEDURE

1. Switch to Engrave mode by either pressing Ctrl/Cmd-3 or clicking Engrave in the toolbar.

2. Inthe Pages panel on the right of the window, double-click First in the Page Templates

section.

Page Templates

Current set

Default Full Score

-

Default
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Laying out and formatting pages
Deleting the copyright text frame (Dorico Pro only)

If the right zone isn't shown, press Ctrl/Cmd-9 to show it.

This opens the First page template in the page template editor.

{@projectTitle@}

{@projectTitle@}

(@projectLyricist@)

& wa-| 1 Y FLows: Al | ¥ pLavERs: All-

[

[

(@projectComposer@)

& wa~ | 1~ Y FLows: all- | ¥ pLAVERS: All-

(@prcjoctCopyrighta)

(@projectCopyright@)

3. Select the copyright text frame at the bottom of the page on the right.

4. Press Backspace or Delete to delete the frame.

(@prajectCopyright®)

Page templates in Dorico act as page pairs, allowing odd-numbered, right-hand pages
to look different to even-numbered, left-hand pages if necessary. You could select the
copyright frame on the left page as well, but then in step 7 you would need to click the

other button.

5. Select the middle handle on the bottom edge of the music frame on the right page.

ks

You can do this by clicking anywhere on the frame edge to select the whole frame and
show the handles, then click the middle handle. Or, when the whole frame is selected,
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Laying out and formatting pages
Changing the staff size

press Tab to switch to having the handle in the top left corner selected, then press
Down Arrow twice and Right Arrow once until the bottom middle handle is selected.

6. Click and drag it down to the bottom page margin.

e You can also press Ctrl/Cmd-Alt/Opt-Down Arrow until it reaches the bottom page
margin.

7. Atthe top of the music area, click Copy right to left [E33].
e Ifyou deleted the copyright frame on the left page, click Copy left to right instead.
8. Atthe top right of the music area, click Apply, then Close.

RESULT

The copyright text frame is removed from both sides of the First page template, and the music
frame now extends to the bottom of the page. Page 1 in the layout automatically updates
accordingly because it uses the First page template and doesn't have any page template
overrides that would prevent it picking up changes to the page template.

Changing the staff size

Staff size is determined using either the height of each space or the height of the staff overall,
for which there are traditional rastral sizes. Finding the most appropriate staff size is often the
quickest way to improve the look of scores, such as when the size is too large and systems start
to overlap.

Although 7 mm is the most commonly used staff size for part layouts, a slightly smaller 6.5 mm
staff size is still fine for a pianist to read from and will further reduce the pages required. Larger
staff sizes are popular among players whose instruments require them to be further from the
stand, such as trombone or contrabass players.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L to open Layout Options.

2. Inthe category list, click Page Setup.

3. Inthe Space Size section, select Size 4 (6.5mm) from the Rastral size menu.
4

Click Apply, then Close.

RESULT
The staff size is reduced, and now the piece fits on three pages.
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Laying out and formatting pages
Changing vertical spacing settings

Walser Capricen No. 2

Walzer-Capricen No. 2

st atempo

Changing vertical spacing settings

Next, you can reduce the default vertical spacing settings to reduce the minimum amount of
space Dorico allows for staves and systems.

Dorico automatically performs collision avoidance calculations for high or low notes, dynamics,
text, and so on. These gaps change the spacing in addition to collision avoidance.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L to open Layout Options.

2. Inthe category list, click Vertical Spacing.

3. Inthe Ideal Gaps section, for Braced staff to braced staff, enter 4 7/8.
4. For Inter-system gap, enter 8.

5. Click Apply, then Close.

RESULT

All staves and systems move closer together, getting the page count close to two.

Walzer-Capricen No. 2
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Laying out and formatting pages
Changing note and cross-staff beam spacing

Changing note and cross-staff beam spacing

In order to fit the remaining music on page 3 onto pages 1-2, you can reduce the minimum note
spacing to fit more bars in each system. At the same time, you can make the gaps between stems
equal for the cross-staff beams.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L to open Layout Options.

2. Inthe category list, click Note Spacing.

3. For Default space for crotchet/quarter note, enter 3 1/4.
4. For Minimum space for short notes, enter 1 1/2.

e Alternatively, click the down arrow to the right of the value field until you reach this
value.

5. Activate Optical spacing for beams between staves.

6. Click Apply, then Close.

RESULT

The minimum horizontal space between notes is reduced, allowing more bars to fit in each
system and bringing the whole piece onto two pages. If that's not the case for you, try adjusting
the parameters covered in the previous tasks slightly until it does.

The cross-staff beams in bars 33-35 now have optical spacing, meaning the gaps between stems
are equal, rather than between noteheads. On balance, this piece looks better with equally
spaced stems and larger gaps between noteheads, but you might find equally spaced noteheads
preferable in other contexts.
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Laying out and formatting pages
Starting on a left-hand page

Starting on a left-hand page

As this layout now fits on two pages, it makes sense to set it up as a two-page spread, with the
first page on the left and the second page on the right.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L to open Layout Options.

2. Inthe category list, click Page Setup.

3. Inthe Page Numbers section, enter 2 for Initial page number.
4. Click Apply, then Close.

RESULT

The initial page number is changed, and the previous page 2 becomes page 3. Because the initial
page now has an even number, Dorico automatically treats it as a left-hand page, and the layout
is updated in the music area to show adjoining pages. The second page is now formatted as a
right-hand page, meaning the page number appears in the top right of the page rather than the
top left.

TIP
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The repeat ending at the top of page 2 sits quite close to the running header and page
number now it's positioned in the top right corner. If you have Dorico Pro, you can edit

the Default page template (like you did to remove the copyright frame from the First page
template) and move the top of the music frames down a little to increase the gap.

In any product version, you could also increase the top music frame margins; however, that
applies to the first page as well, which has less vertical space due to the title and composer
information.
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Changing stem directions

e If you have Dorico Elements or Dorico SE, you could create a title page in another

application, then combine it into the exported PDF of the project so that the resulting
document has three pages.

If you have Dorico Pro, instead of changing the initial page number, you could insert an
empty page at the start of the layout and create a title page using text and graphics frames.
We won't cover that in this guide, but you can refer to video tutorials such as this one.

Changing stem directions

In order to help clarify which notes are played by the right and left hands, the stems of some
notes point in a different direction to the default according to their pitch. To match this, you can
change the stem direction of individual notes.

PROCEDURE
1. Inbars 30, 31, 72, and 73, Ctrl/Cmd -click the Cs.
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e You can zoom in to make notes appear larger by, for example, pressing Ctrl/Cmd-= or
Z or using the zoom options in the status bar at the bottom of the
project window.

2. Press F to flip the stem direction of the selected notes.

e Because the stems of notes on the middle staff line can point upwards or downwards
depending on the surrounding context, Dorico also flips the stem of the Bbs in bars 30
and 72 now the Cs in those bars have up stems. However, the Bbs should have down
stems to differentiate between the hands.

3. Select the Bbs in bars 30 and 72, then press F.

RESULT
The stems of the selected notes are flipped: the Cs now point upwards and the Bbs downwards.
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Laying out and formatting pages
Changing beam grouping

NOTE

We don’t recommend flipping the direction of stems when instead you should change notes to
an up-stem or down-stem voice. Where rests aren't shown, Dorico automatically changes the
stem direction of notes according to their pitch, regardless of their voice.

Changing beam grouping
Dorico automatically beams notes according to the prevailing meter (time signature). The
original edition of this piece has some beam groups that don't follow the meter, so you must
change the beam grouping manually.

PROCEDURE
1. Inbars5,7, 21,23, 47,49, 63, and 65, Ctrl/Cmd -click the Fs on the top staff.

RO

2. Choose Edit > Beaming > Make Unbeamed, or right-click and choose this option from the
context menu, to separate all selected notes from their beam groups.
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3. Inbars 14-17 and 56-59, Ctrl/Cmd -click the third eighth note in each bar on the top staff.

e A

14
A L [—
%ﬁﬁg":.t:,_—p_f_,__.ﬁ_“ihlt%%wii e —— i ——
1 —— :ﬁrbﬂ:i__‘j:\—/;

e s g gede [ ;5%

Ay

4. Choose Edit > Beaming > Split Beam, or right-click and choose this option from the context
menu, to split beams to the left of the selected notes but leave them beamed on their other
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5. In bars 33-35, select the first 32nd note Fs in each bar; that is, the fourth note in each bar.
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6. Choose Edit > Beaming > Split Beam, or right-click and choose this option from the context
menu, to split beams to the left of the selected notes.

T

RESULT

You have changed the default beam grouping in the selected bars.
TIP

If the beam grouping changes you want are consistent across many bars, you can specify them
as part of the time signature, such as by entering [2+3+2]/8 into the popover for a 7/8 time
signature grouped in 2+3+2. In Dorico Pro and Dorico Elements, you can also change the default
beam grouping in different circumstances on the Beam Grouping page in Notation Options
(key command Ctrl/Cmd-Shift-N ).

Aligning dynamics

If you added dynamics separately, you might notice they aren't aligned vertically. You can group
dynamics together so they align in a row.

PREREQUISITE
You are in Write mode (press Ctrl/Cmd-2).

PROCEDURE

1. In Write mode, select the dynamics you want to group together in a single group. For
example, we added all the hairpins in bars 37-40 separately so they aren't aligned.
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Adjusting the shapes of slurs (Dorico Pro and Dorico Elements)

2. Choose Edit > Dynamics > Group Dynamics, or right-click and choose this option from the
context menu.

RESULT

The selected dynamics are grouped together and automatically align. When you select any
dynamic in a group, the other dynamics in the group appear highlighted.
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Grouped dynamics function as a single unit, so for example, lengthening/shortening commands
now apply to the group as a whole rather than individual dynamics within it.

TIP

e In Dorico Pro and Dorico Elements, you can also graphically align dynamics in a row without
grouping them. You can do this in Engrave mode by selecting dynamics and choosing Edit >
Dynamics > Align Dynamics, which can only apply in individual layouts, whereas grouping
dynamics applies to all layouts.

e You can also link dynamics vertically, which connects the same dynamics across multiple
staves.

AFTER COMPLETING THIS TASK

Continue grouping other dynamics together that you want to align and have in the same group.
For example, in bars 51-52 and 53-54.

Adjusting the shapes of slurs (Dorico Pro and Dorico
Elements)

A number of slurs follow their default curvature direction and shape according to the voices they
were added to, whereas in the original edition they cover whole phrases, including starting from
rests. Because slurs can't start or end on rests in Dorico, you must adjust their shapes manually
to achieve this effect.

NOTE

Although you can change the curvature direction of slurs in all product versions, any further
adjustments are only possible in Dorico Pro and Dorico Elements. Therefore, we do not
recommend these steps for Dorico SE users.

PROCEDURE
1. Inbars 9-12, Ctrl/Cmd -click the slurs on the top staff.
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2. Press F to change their curvature direction so they curve upwards.
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3. Ifyou are not already in Engrave mode, press Ctrl/Cmd-3 to switch to Engrave mode.
4. Select the start handle of the flipped slurs.
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e You can show handles on all items, not just selected items, by choosing Engrave > Show
Handles > Always. This can make it easier to select individual handles on multiple items.

5. Press Ctrl/Cmd-Alt/Opt-Up Arrow until the endpoints are positioned above the quarter
note (crotchet) rest.

e We recommend pressing Ctrl/Cmd-Alt/Opt-Up Arrow four times.
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Select the control points one at a time and move them until the slurs curve around the beam.

e The control points are the inner pair; that is, the second and fourth handles.
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e The poco rit. does not automatically move out of the way of the slur as this is arguably a
creative choice of slur placement. You can select the poco rit. and A tempo markings, then
press Ctrl/Cmd-Alt/Opt-Up Arrow to move them graphically upwards.

RESULT

You have changed the curvature direction and shape of the slurs, and optionally moved the
tempo marks in bars 11-12 out of the way of the slur’'s new position.

AFTER COMPLETING THIS TASK

Repeat these steps for other similar slurs in bars 13-14 and 51-56.

Moving items graphically (Dorico Pro and Dorico Elements)

As a final step, you can tweak the exact graphic positions of items in Engrave mode in Dorico
Pro and Dorico Elements. In this task, you will improve the positions of left and right hand

indications, change the angles of some hairpins, and move another hairpin to allow the top and
bottom staves to be closer together.

PREREQUISITE

You are in Engrave mode (press Ctrl/Cmd-3).

PROCEDURE

1. Inbars 72-73, select the “I.H."” text items below the top staff.
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In the Properties panel at the bottom of the window, activate Avoid collisions but leave the
checkbox deactivated.

e Ifyou can't see the Properties panel, press Ctrl/Cmd-8 to show the lower zone, then
select Properties [F in the lower zone toolbar.
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e When the property is activated but the checkbox is deactivated, the selected text items
do not automatically avoid collisions or contribute towards Dorico’s vertical spacing
calculations. When the property is deactivated, text items follow the default setting for
text collision avoidance (Dorico Pro users can change this on the Text page in Library >
Engraving Options).

3. Inbars 39-40, select the final hairpin in the group.
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Press Ctrl/Cmd-Alt/Opt-Up Arrow once to move the hairpin upwards.
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e The bottom staff automatically moves upwards slightly with the reduced pressure on
vertical spacing.

In bars 33-35, select the end handle on each hairpin (the middle handles at the end).
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e You can show handles on all items, not just selected items, by choosing Engrave > Show
Handles > Always. This can make it easier to select individual handles on multiple items.

Press Ctrl/Cmd-Alt/Opt-Up Arrow five times.
Select the start handles on each hairpin (the middle handles at the start).
Press Ctrl/Cmd-Alt/Opt-Right Arrow twice, then Alt/Opt-Up Arrow twice.

e Alt/Opt plus arrow keys moves items graphically a small amount. Adding Ctrl/Cmd as
well moves items graphically by a larger amount.
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RESULT

You have deactivated collision avoidance for the “I.H.” text items, allowing them to be positioned
between the staff and the hairpin, and moved both whole hairpins and individual hairpin handles
to change their angles.

To provide a stable result, most graphical edits in Engrave mode do not affect the positions of
other items.

AFTER COMPLETING THIS TASK
There's always more detail that you could look at when engraving, but for now we think this
piece looks good.

In the next set of steps, you can play the piece back to hear the results of your work and make a
few adjustments to how it sounds in playback without affecting its notation.
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Playing back music

The next step in the process is listening to the music and making changes if required. There
are many different ways you can adjust how your music sounds in playback; the following tasks
cover a few simple adjustments.

In Play mode, the central area of the project window, which previously showed staves on pages,
becomes the track overview, with music previewed in tracks. Selecting a track in the track
overview allows you to show it in the Key Editor in the lower zone, and edit its sounds in the
Track Inspector in the left zone. You can use the flow selector at the top left of the window to
view other flows, but only when nothing is selected in any flow.

At the top of the track overview and the Key Editor, there are rulers. The ruler at the top of the
track overview shows bar numbers and beat divisions according to the prevailing time signature,
while the ruler at the top of the Key Editor shows divisions according to the Key Editor rhythmic
grid resolution.

The playhead (the green vertical line) is always visible in Play mode, not only during playback.

Setup Write Engrave Play Print  Fullscore ~

Flow:  Walzer-Capricen No.2 v = B T [C7
Track Inspector VST and MIDI Tempo

VST Instruments v Piano

+ &

MIDI Instruments.

staff (a), Up-stem voice 1

+ Add Editor

1 | R~ ConcertPitch

The Key Editor in the lower zone allows you to edit notes and other aspects of tracks, such as
note velocity and dynamics. It displays pitched notes in a piano roll editor, and unpitched notes
in a percussion editor.

By default, the music shown in the Key Editor follows your selection. Notes in the voice you are
currently editing appear with bold colors; notes in other voices appear in a lighter shade.

TIP

e To make the whole Key Editor taller/shorter, click and drag Resize Lower Zone B in the Key
Editor toolbar upwards/downwards.

e To make individual editors taller/shorter, click and drag their splitters == mm == upwards/
downwards. When the mouse pointer is in the correct position, it appears as a split arrow.
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e You can zoom in/out of the Key Editor using the controls on the right and bottom edges. You
can also change the vertical zoom by pressing Ctrl/Cmd-Shift-H / Ctrl/Cmd-Shift-G, and the
horizontal zoom by pressing H/G.

Changing the audio output device

Before you start playing back music, it's worth checking that your audio output device is correctly
set up so you can hear your music.
PREREQUISITE

If you connected an external device you want to use for audio output after starting Dorico, you
must restart Dorico.

PROCEDURE
1. Press Ctrl/Cmd-, to open Preferences.
2. Inthe category list, click Play.

3. Inthe Audio Device subsection at the bottom, click Audio Device Setup to open the Device
Setup dialog.

4. Select the audio output device you want to use from the ASIO Driver menu.

5. If you want to edit settings for the device, click Device Control Panel to open the settings
dialog.

e Windows users: To allow sound from other applications alongside Dorico, such as online
videos, deactivate Allow ASIO host application to take exclusive control of selected
port configuration.

e macOS users: To allow Dorico to switch between computer output and headphones
automatically, activate Automatically Configure Devices.

6. Click Close for each dialog.

RESULT
Your audio device output is changed, including optionally its device settings.

Applying a playback template

Dorico uses playback templates to load all the required sounds for the instruments in your
project. If you have installed the sounds provided with your Dorico version, you can apply the
corresponding playback template.

PREREQUISITE

You have downloaded and installed the sounds provided with your Dorico version. You do
not have to install them to run Dorico, but because they come with playback templates and
expression maps set up, they are often the simplest way to hear your music played back.

PROCEDURE
1. Choose Play > Playback Template to open the Apply Playback Template dialog.
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Search...

HSSE (Elements)

HSSE (SE)

HSSE+HSO (Pro)

Silence

+a 70

Apply and Close

2. Select the playback template for your product version.
e Ifyou have Dorico Pro, select HSSE+HSO (Pro).
e Ifyou have Dorico Elements, select HSSE (Elements).
e Ifyou have Dorico SE, select HSSE (SE).

3. Click Apply and Close.

RESULT

The selected playback template is applied to the project. If it was already applied, it is re-applied,
resetting the playback template back to its defaults.

In the VST and MIDI panel on the left of the window, a plug-in instance is loaded with sounds for
the piano.

Track Inspector VST and MIDI

VST Instruments

02 - HALion Sonic SE

02 - HALion Sonic SE

1

If you want to open the VST instrument window, click Edit Instrument [&.

Playing back the piece

With piano sounds loaded, you can now listen to the whole piece played back. You can do this in
any mode.

PROCEDURE
e Press Shift-Alt/Opt-Space to start playback from the beginning.

e If the playhead was not already at the beginning of the flow, it jumps there and moves
along with the playback.
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e You can also start playback from the current position of the playhead by pressing Space
or Enter, or from a selected item by pressing P. Selecting multiple different items on
specific staves and pressing P only plays back those staves.

RESULT

Playback starts from the beginning of the flow and stops at the end, allowing you to listen to the
whole piece. If you had other flows in the project, playback would continue to the next flow after
a short gap between them.

TIP

e Ifyou have problems hearing sounds, check this troubleshooting video. Windows users: in
order to watch the video, make sure your audio output device settings allow sounds from
other applications; alternatively, quit Dorico before watching the video.

e To change the overall volume in playback without affecting dynamics in the music, use the
Mixer, either in the lower zone or in the Mixer [ window.

AFTER COMPLETING THIS TASK

If you want to change the overall tempo, switch back to Write mode (press Ctrl/Cmd-2), select
the Grazioso tempo mark at the start, and change the value for Tempo (bpm) in the Tempo
group of the Properties panel.

Changing dynamic levels in playback

You can change the levels of dynamics in playback without affecting their appearance in the
music. To demonstrate this, these steps focus on bars 21-30, adjusting the volume of the
consecutive crescendo hairpins and adding a subtle unmarked diminuendo leading into bar 30 to
shape the phrase.

PREREQUISITE
e The lower zone is shown (press Ctrl/Cmd-8).

e Key Editor B is selected in the lower zone toolbar.

PROCEDURE

1. Atthe bottom left of the Key Editor, click the editor menu and select Dynamics to show the
Dynamics editor.

Velocity

Velocity

MIDI Pitch Bend
Dynamics k
Tempo H H

Add Automation

e If you have space on your screen to show multiple editors at once, you can instead
click Add Editor [§ and select Dynamics to show the Dynamics editor in addition to the
previous editor.
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Playing back music
Changing dynamic levels in playback

Staff (a), Up-stem voice 1

Playing Techniques

x .
Dynamics

e Thereis a cumulative volume increase across the three crescendo hairpins in bars 21-26.
However, they most likely indicate shaping that resets at the start of each phrase, so you
can adjust their start dynamic levels.

2. If Select is not already selected, click Select ¥ in the Key Editor toolbar.

e You can also right-click and hold in the Key Editor, then select Select [¥ from the quick
tool selector.

3. Inbar 23, click and drag the crescendo start point downwards until the readout displays -1;
that is, until it is at a similar level to the start of the crescendo in bar 21.

21 22 23 24 25 26
< < <

e The crescendo end handle also moves down proportionally.

e You could also do the same for the next crescendo in bar 25, but the current phrasing
with the third crescendo sounding a bit louder feels quite natural. When you release the
mouse after lowering the crescendo end in bar 24, the crescendo in bar 25 also lowers
accordingly.

4. Inthe Key Editor toolbar, click Draw [ to select the Draw tool.

e You can also right-click and hold in the Key Editor, then select Draw [ from the quick
tool selector.

5. Inbar 22, click on beat 3 at a similar level to the start of the previous and next crescendos to
input a dynamic point.

21 22 23 24 25 26
< < <

e This means the downbeat in bar 23 plays back at the lower dynamic level, which sounds
more natural.
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22 23 24 25 26

I—// . l/ ./

< < <

e The next steps involve the Velocity editor. If your Velocity editor is already shown, you
can skip the next step.

6. Click the editor menu and select Velocity to show the Velocity editor.
e Velocity controls the dynamics of non-sustaining instruments, including the piano.

7. Inthe Key Editor toolbar, click Transform @] to select the Transform tool.

e You can also right-click and hold in the Key Editor, then select Transform [@ from the
quick tool selector.

8. Click and drag in the Velocity editor, from the middle of bar 26 to the end of bar 29, to make
a Transform selection around the velocity bars within that region.

25 26 27 28 29 30

x Velocity v

Selection 4|}

9. Atthe top right of the Transform selection, click and drag Ramp Tilt Right ¥ downwards
until you are happy with the slope.

25 26 27 28 29 30

X Velocity v 1.00-0.55x

Selection 4|}

e When you release the mouse, all the note velocities within the Transform selection
are adjusted. Their values are changed proportionally, meaning the natural variation in
velocity that already existed is preserved.

'\ [

RESULT
You have changed the dynamic levels in a single phrase without affecting the notated music.

AFTER COMPLETING THIS TASK

To listen to just the affected bars to check the result, you can click in the ruler at the top of the
event display to move the playhead to that position and press Space or Enter to start or stop
playback from that position.
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Changing the poco rit. final tempo

The poco rit. in bars 42-43 sounds like it needs a little more time. To achieve that, you can reduce
its final tempo.

PREREQUISITE
Tempo FY is active at the top of the track overview.

PROCEDURE

1. Inthe track overview, click the Tempo track to show the Tempo editor in the lower zone.

e You can also select Tempo from the menu in the editor header, or click Add Editor
and select Tempo to show the Tempo editor in addition to the previous editor.

2. Inthe Key Editor toolbar, click Select [§ to select the Select tool.

e You can also right-click and hold in the Key Editor, then select Select [ from the quick
tool selector.

3. Atthe start of bar 43, click and drag the rit. end point downwards until the readout displays

Tempo

N
Range max.: 250

88

RESULT
The final tempo of the poco rit. is changed.

TIP

You can also change the final tempo of gradual tempo changes in Write mode by using the
Final tempo % property in the Tempo group of the Properties panel. When you change the
final tempo of gradual tempo changes in the Tempo track, Dorico calculates the corresponding
percentage change.

AFTER COMPLETING THIS TASK

Click in the ruler in the Key Editor or track overview anywhere in bar 41 to move the playhead
there, then press Space or Enter to start playback and hear the effect this has on the tempo.
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Changing the played duration of notes

After reducing the final tempo of the poco rit. in the previous task, it sounds like the played
(sounding) duration of the last chord in bar 42 should be adjusted for a smoother transition
back into the starting material. You can change the played duration of notes in Dorico without
affecting their notated duration.

These adjustments are subjective, but we suggest making the quarter note (crochet) sound a
little shorter and the eighth notes (quavers) sound a little longer to create the effect of a breath
before the start of bar 43.

PREREQUISITE
Make sure that Played Durations [ and Select § are selected in the Key Editor toolbar.

PROCEDURE

1. Ifrequired, adjust the size and zoom of the Key Editor, so that notes in the piano roll editor
appear comfortably wide and tall for you to make adjustments.

You can use Resize Lower Zone B and the zoom controls at the right/bottom of the
Key Editor. You can also press G to make notes appear wider, and Ctrl/Cmd-Shift-G to
make notes appear taller.

2. Inbar 42, click and drag the right end of the Eb quarter note on beat 3 to the left a little to
shorten its sounding duration.

Piano 42 43

HMHH;HHI

3. Click and drag the right end of the other notes on beat 3 to the right a little to lengthen their
sounding duration.
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Changing the played duration of notes

e They don't have to line up; in fact, having them end at slightly different times creates a
more natural effect.

Piano 42 43
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Click in the ruler in the Key Editor or track overview anywhere in bar 41 to move the playhead
there, then press Space or Enter to start playback and hear how this sounds.

If you want, you can continue tweaking the played durations of notes, dynamics, and/or
tempo fluctuations throughout the piece.

NOTE

Moving the start/end positions of dynamics and tempo marks in their respective editors,
such as making a rit. start on beat 1 rather than beat 2, affects where those items appear
in the music. This also applies to moving or lengthening/shortening notes with Notated

Durations [ selected in the Key Editor toolbar.
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Printing and exporting

Once you are happy with how the piece looks on the page and sounds in playback, you can print
and export it in a variety of formats, including graphics and audio files. The following tasks cover
a few common printing and exporting operations.

In Print mode, the area in the middle of the project window becomes the print preview area.
It shows the layout selected in the Layouts list on the left of the window, not from the layout
selector in the toolbar at the top.

The panel on the right is the Print Options panel, where you can find all the printing and
exporting options. You can set different options for different layouts and then print and/or
export them all together with those settings retained.

Setup  Write Engrave Play  Print 111000 [ an I'n;‘ “

Layouts Destination
> @ Fullscore .
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System Dialogs:

Page Setup...

Page Width

Printing hard copies

If you have a printer connected to your computer, you can print hard copies of layouts directly
from Dorico. If you don’t have a printer or don't want to print a hard copy, you can skip this task.

PREREQUISITE
You are in Print mode (press Ctrl/Cmd-5).

PROCEDURE

1. Inthe Print Options panel on the right, choose Printer in the Destination section at the top.
2. Select the printer you want to use from the menu.

3. Enter the number of hard copies you want to print into the Copies field.

4. Ifyou entered 2 or more, activate/deactivate Collate copies.
5

In the Job Type section, select the appropriate print arrangement from the menu.
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Exporting to PDF

If your printer can only print A4, select Normal.

If your printer can print A3 and you have not added a title page, select 2-up.

If your printer can print A3 and you have added a title page, select Booklet.

6. If you selected Normal or 2-up, choose All for Print range.
7. 1Inthe Page Setup section, choose the options appropriate for your printer and job type.
e For the Normal job type: select A4 paper, Portrait [E] orientation, and Fit to Paper.
e For 2-up and Booklet job types: select A3 paper, Landscape [ orientation, and Fit to
Paper.
8. For Booklet jobs only: In the Duplex Printing section, choose the options appropriate for
your printer.
e Both sides automatically is only available for printers that support automatic
duplexing.
e You can refer to the Operation Manual for more information about the duplex printing
options.
9. When you are happy with your settings, click Print at the bottom of the panel.
TIP
To show a preview of the full page in the print preview area, click Whole Page in the bottom
right of the project window.
RESULT

The full score layout is printed according to your options.

Exporting to PDF

You can export any layout as PDF, PNG, SVG, and TIFF graphics files. Because the most common
and useful format for musical scores is arguably PDF, this task covers exporting to PDF with a
watermark to indicate it's a proof.

PREREQUISITE
You are in Print mode (press Ctrl/Cmd-5).

PROCEDURE

1.

In the Print Options panel on the right, choose Graphics in the Destination section at the
top.

Select PDF from the menu.
Choose Color.

e Asyou will add a watermark to this layout, you need Color to show this. You would also
need Color if you have items with changed colors or opacity in a layout.

Apart from the watermark, the difference between Mono and Color would be minimal
for this layout. Some printers print black differently when the document is color versus
mono.

e Layouts exported as Color graphics have transparent backgrounds.

e The Resolution setting does not affect PDF and SVG files as they are vector formats.
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Exporting to PDF

4. Click Choose Folder B beside the Destination folder field to open the File Explorer/macOS
Finder.

5. Locate and select the destination folder you want.

6. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Destination
folder field.

7. If you want to change the file name recipe (the naming structure used for the exported PDF),
click File Name Options to open the Export File Names dialog, then change the file name
recipe for PDF files.

NOTE

Changing the file name recipe also affects all future projects you open on your computer.
8. Make sure that the rest of the settings in the Print Options panel are correct to export with
separate portrait pages, which they should be by default.

e Inthe Job Type section, select Normal and All Pages.

e Inthe Page Setup section, choose Portrait [E.

9. Inthe Annotations section, activate Watermark, then enter PROOF into the value field.

TIP

If you have Dorico Pro and want longer watermark text, you can reduce the Print
Watermark Font font size in Library > Font Styles.

10. Click Export.

RESULT
The full score layout is exported as a PDF with your settings and the “PROOF” watermark.

Walzer-Capricen No. 2
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Exporting the audio

You can export the audio of projects as MP3 or WAV audio files; for example, to share how a
piece sounds with someone who does not have Dorico.

PROCEDURE
1. In any mode, choose File > Export > Audio to open the Export Audio dialog.

Flows Players

Export each selected flow as a separate file . Export players as separate files

Select flows to export: Select players to export:

Walzer-Capricen No. 2

Select All Select None

Export to:

/Users/user/Documents/Dorico Projects

Audio Export Options

MP3 (.mp3) FLAC (.flac) m
Bit depth: m 24-bit  32-bit

. Broadcast WAVE

Reverb tail (s):  1.00

Cancel

2. Inthe Flows section, deactivate Export each selected flow as a separate file.

e If this option were activated, the resulting audio file would be inside an additional folder
named after the flow. In a single-flow and single-player project like this one, the options
for exporting flows and players as separate files make no significant difference, but
would be useful if you wanted to export stems of individual players separately for each
flow, for example.

Click Choose Folder [ beside the Export to field to open the File Explorer/macOS Finder.
Locate and select the destination folder you want.

Click Choose to insert the new path in the Export to field.

o W

In the Audio Export Options section, choose MP3 (.mp3).

e As part of these steps, we suggest exporting as MP3 because the resulting MP3 file size
is much smaller than WAV or FLAC files.

7. Optional: Change the Reverb tail (s) duration.

e This controls the amount of time added at the end of the audio file to accommodate
reverb that continues sounding after the music has finished.

8. Click OK to export the audio as an MP3 file and close the dialog.

RESULT
The project is exported as an MP3 audio file in a folder inside the selected destination folder.
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Further notations

Congratulations! You have completed the Dora Pejacevi¢ “Walzer-Capricen No. 2" piano piece
project. We hope you enjoyed the process and learned useful Dorico operations along the way.

In the following tasks, you will build on the inputting techniques you've already learned and
extend them to other common notations, including lyrics, chord symbols, and rhythm slashes.
There is also an overview of how Dorico handles part layouts.

The song used in these tasks is Gertrude “Ma" Rainey's “See See Rider Blues”. A PDF of the
excerpt used in these tasks is available on steinberg.help, along with a Dorico project set up as a
starting point for the following tasks.

NOTE

As the project contains more than two players, it opens in read-only mode in Dorico SE. Dorico SE
users must instead set up separate Dorico projects, each with up to two players, for these tasks.

Adding lyrics

Perhaps unsurprisingly at this stage, Dorico has a dedicated popover for inputting lyrics that
stays open after each lyric/syllable. You can press different keys to advance the popover to the
next note automatically, depending on whether the lyric/syllable needs a hyphen after it or not.
PREREQUISITE

e You have input the vocal melody. Although you can input lyrics independently of notes, it is
much easier to input lyrics with notes already there.

e You are in Write mode (press Ctrl/Cmd-2).

PROCEDURE

1. In Write mode, select the first note on the vocal staff; that is, the C in bar 5.
e You can do this in the full score or the voice part layout.
2. Press Shift-L to open the lyrics popover.

3. Enter the first syllable I'm into the popover.
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Further notations
Adding lyrics

10.

1.

12.

e Pressing Space tells Dorico the lyric you input was a complete word, or the final syllable
in a multi-syllabic word.

Enter so into the popover, then press Space.

e The next word comprises three syllables, so you must advance the popover differently.
Enter un into the popover, then press -.

e The hyphen between syllables does not appear until you input the next syllable.

Enter hap into the popover, then press -.

9: | | A — [— I
A h e A ) | | ] 3y ) | ] N7 | | 1| oy |
(GEEEEN NN ——H
& _] & & _] ~~— _E
QJ ) - R & _"é' =
I'm so un - —

In bar 6, enter the lyrics I feel so blue, into the popover.

In bar 7, enter the lyrics I al-ways feel so sad, into the popover.

: : [
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I al- ways feel so

e You might notice that ways and sad, are left-aligned with their noteheads rather than
center-aligned because they span more than one notehead, and that after you input
sad, Dorico lowers the whole line to avoid a collision with the A.

e Dorico counts tied notes as a single note.

Continue inputting the lyrics up to the end of bar 11.

I made a mis-take, right from the start, Oh, it seems so hard to
e The next syllable is sung over two notes.
In bar 12, enter part, into the popover, then press Space twice.

e This advances the lyrics popover two notes ahead. When you press Space the second
time, Dorico recalculates the horizontal alignment of the lyric: it is now left-aligned with
the notehead rather than center-aligned.

h [ 1 | | | P |
L [y, L 1 J— L i
N T | T N | 1 | |
\:)V dl l- | | I\, .I | I) .I. | I} .I T I‘ I\rl
* v g - e ¢ "D
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Further notations
Adding fermatas

13. Continue inputting the lyrics until the end of bar 26.

A-bout this let-ter, that I will write, I hope he will re-mem-ber, when he re-ceives it,
See, see, ri-der, see what you done done, Lawd, lawd, lawd, You made me love you, now
your gal done come. You made me love you, now your gal done come.

e The lyrics lawd, on beat 3 in bar 20 and come. at the end of bar 22 each require two
Space presses. All other lyrics only require a single Space press.

RESULT

You have input the lyrics for the first verse and chorus. Dorico automatically shows lyric hyphens
between syllables and lyric extender lines for lyrics on tied notes or that span multiple notes
when there is sufficient horizontal space. Dorico also automatically left-aligns lyrics that span
more than one note, including tied notes, and calculates a consistent vertical position for whole
lyric lines in each system.

TIP

If you have the lyrics written out with syllables separated appropriately using hyphens
already, such as in a text editor or existing lines of lyrics in Dorico, you can copy and paste
them into the lyrics popover. When the lyrics popover is open and the lyrics are copied to
your clipboard, you can simply press Ctrl/Cmd-V to input each syllable one at a time. For
syllables that span more than one note, you must press - or Space to tell Dorico how long
they should last.

You can change the alignment of individual lyrics by selecting them and using the Lyric text
alignment property in the Lyrics group of the Properties panel. In some cases, this can
reduce how much notes are moved horizontally to accommodate lyrics.

Adding fermatas

There is a pause in the recording of this song in the beats before the first chorus. One way of
notating this is to use a fermata, also known as a pause mark.

PROCEDURE
1. Inbar 16, select the G on beat 3 on the vocal staff.
2. Press Shift-H to open the holds and pauses popover.
3. Enter fer into the popover.
e
16
A N | — A I o
i 1 L Jr— ] I ] | I— | A 1 AY I | |
| ] N | | | | 1 ] | 1 1N\ | - |1
i — e o 3 e
_‘_ T ~— _‘I_- 1
when he re - ceives it, See, see, ri - der see what_ you
4. Press Return to close the popover and input a fermata at the selected rhythmic position.
5. Select the C on beat 4 and repeat steps 2 to 4.

16
A Fe ! | — A | o
)" A Y r— | | | | I |\ I A Y I 3
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when he re - ceives it,  See, see, ri - der see what_ you
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Further notations
Adding a mute playing technique

RESULT

You have input two fermatas on the last two beats in bar 16. Dorico automatically shows
fermatas on all staves, including adjusting the note or rest they appear on according to the
contents of each staff.

Selecting a fermata on one staff selects it on all staves, because they are all representations of
the same, single item. On the bottom piano staff and trombone and banjo staves, it appears
above the closest note to its rhythmic position, in this case the whole note or bar rest, but there
are attachment lines indicating its actual position on each staff.
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hope he will re-mem-ber, when he re-ceives it,
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h
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X
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@ !- !-—§ ¢ ¢ - e
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NOTE

e Fermatas do not currently affect playback.

e You can also add fermatas using the Holds and Pauses panel on the right of the window,
which you can show by clicking Panels EJ, then Holds and Pauses [ in the Notations
toolbox.

Adding a mute playing technique

To indicate that the cornet player should use a mute, and to use a muted cornet sound in
playback, you can input a con sordino playing technique.

PROCEDURE
1. Inbar 1, select the first note on the cornet staff.
2. Press Shift-P to open the playing techniques popover.

3. Enter con s into the popover.

con Sl ]

con sord N—H_ | (o {/~ .

L] —\

I~e
u
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Further notations
Adding chord symbols

e Because the playing techniques popover requires exact popover entries in order to
create specific playing techniques, a menu with valid playing techniques appears when
you start entering into the popover.

4. Press Down Arrow to select con sord.

'IIII con sord| \
\ [— o

L] -\

1
o
BT

5. Press Return to close the popover.

RESULT

A con sordino playing technique is input. It has an associated “Muted” playback technique. Dorico
uses playback techniques to link playing technique notations with techniques or articulations in
sound libraries in order to produce the correct sounds in playback.

Like other notations, playing techniques are automatically aligned relative to their rhythmic
position. Text playing techniques are left-aligned, whereas glyph playing techniques are center-
aligned. Dorico also performs automatic collision avoidance, meaning the tempo mark moves
upwards to accommodate the playing technique.

Laid back blues /= 76)
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Adding chord symbols

The input method for chord symbols is similar to lyrics in that you can advance the chord
symbols popover after inputting each chord symbol without closing it, allowing you to input
sequences of chord symbols in one go.

An important aspect of chord symbols in Dorico is that they exist globally by default, meaning
you can input a chord symbol once but show the same chord symbol for all players in the
ensemble if needed. You can also input local chord symbols if one player needs a different chord.

PROCEDURE
1. Inbar1, select the bar rest on the banjo staff.

e For simplicity, we recommend inputting chord symbols onto staves that you want to
show chord symbols on anyway.

2. Press Shift-Q to open the chord symbols popover.
3. Enter C7 into the popover.

Thn

4. Press Space four times to advance the popover to the start of bar 2.
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Further notations
Adding chord symbols

"~
1

Thn |5 | - -

x
K

e Each time you press Space, the chord symbols popover advances one beat according to
the current time signature, which is one quarter note (crotchet) in this song'’s 4/4 time
signature.

5. Enter G7/D into the popover, then press Space twice.

6. Enter C7 into the popover, then press Space twice.

!E\l y /1
|7 b4 |
c7 G7/D c1

2%
Ban. I 3 L - -
=

7. Enter Finto the popover, then press Space twice.

8. Inputthe remaining chord symbols in bars 3-4, pressing Space once between them.
G#dim7, Gm7, F, C7, then F.

RESULT

You have input the chord symbols in the first four bars of the song. They automatically appear
above rhythm section instrument staves, which in this project are the banjo and piano.

™o | = = = =
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” Cc7 G7/D C7 F G#dim7 Gm7 F c7 F
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A R e———— — P k 2 = #r i » —
Ll 3 { I ‘ | Il 1 I 1 I
NOTE

Some chord symbols might look different when input compared to what you entered into the
popover, such as if you input the Fdim7 in bar 5 as Fdim. Dorico uses default settings to
determine the appearance of chord symbols based on their type, rather than your popover entry.

e If you have Dorico Pro, you can change these settings on the Chord Symbols page in
Library > Engraving Options.

e Ifyou have Dorico Elements, you can change these settings in the Library > Chord Symbols
dialog.

AFTER COMPLETING THIS TASK

e Continue inputting chord symbols for the rest of this excerpt, remembering that Return
closes the popover and Space advances it by one quarter note for each press.

e Some chord symbols collide with barlines, such as the Fdim7 in bar 5. You can change the
alignment of these chord symbols to avoid the collision by selecting them, activating the
Alignment property in the Chord Symbols group of the Properties panel, and selecting
Center from the menu.
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Further notations
Adding rhythm slashes

Adding rhythm slashes

As this blues song involves lots of improvisation, you can use slash regions to fill bars with
rhythm slashes to indicate those players should improvise.

PROCEDURE

1.

In bar 1, select the bar rest on the trombone staff.

e We recommend doing this in the full score, where by default empty bars are not
consolidated into multi-bar rests.

Shift-click the bar rest in bar 4 on the trombone staff.

Press Shift-R to open the repeats popover.

Enter slash into the popover.
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Return to close the popover and input a slash region spanning the selection.
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e Dorico automatically displays the appropriate number of slashes for the duration and
the current time signature. For example, if this were in 6/8, Dorico would show two
dotted slashes in each bar.

Repeat steps 1 to 5 for the banjo and top piano staff.

Alternatively, you can select the slash region on the trombone staff and Alt/Opt-click the
start of bar 1 on the banjo staff and top piano staff.

e However, in the recording, only the clarinet plays on beat 4 in bar 4.
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Select any part of the slash regions in bars 1-4 on the trombone, banjo, and piano staves.

2.
3.
4.
Crtin Bb
Thn
5. Press
Thn
6.
TIP
Cl.in Bb
Crt in Bb
Thn
Ban.
Pno
7.
8.

Press Shift-Alt/Opt-Left Arrow to shorten the slash regions back to the end of beat 3.

e The number of presses required depends on your rhythmic grid resolution Il
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Further notations
Adding rhythm slashes
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9. Inbar 5, select the bar rest on the trombone staff.
10. Shift-click or Ctrl/Cmd -click the bar rest in bar 16 on the trombone staff.

11. Input a slash region.

e If these regions were adjacent, the second would have a different highlight color to
distinguish them.

12. Repeat steps 9 to 11 for the banjo.
13. Input slash regions on the cornet staff in bars 5-7 and bar 9 (beat 2) to bar 12.

e You should now have rhythm slashes throughout bars 1-16 for the cornet, trombone,
and banjo. However, the fermatas in bar 16 do not appear automatically in slash
regions. Instead, you can input notes in stemless slash voices on those beats.

14. Select any part of the slash regions in bars 5-16 on both the trombone and banjo staves.

ON~Y
Crt in Bb —— -
-
Thn - — -
Ban.  — =

15. Press Shift-Alt/Opt-Left Arrow to shorten the slash regions back to the end of beat 2.

e The number of presses required depends on your rhythmic grid resolution IR
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Further notations

Adding rhythm slashes

16.

17.

18.
19.

20.

21.
22.

{ 1HID)]

LITRARD

In bar 16, double-click the trombone staff on beat 3; that is, just after where the slash region
ends.

Press Shift-Alt/Opt-V until the caret indicator shows you have created a new, stemless slash
voice.

|
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Press 6 to select quarter notes (crotchets).

Press Y twice to input two quarter note stemless slash notes.
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~
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e Y inputs default pitches, and is particularly useful for unpitched percussion. Clefs
determine the default pitch for pitched instruments, such as G on treble clef staves.

Press Left Arrow until the caret is at the start of beat 3 in bar 16, then press Down Arrow
to move the caret down to the banjo staff.
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Repeat steps 17 to 19.

Press Esc or Return to stop note input.

RESULT

You have input slash regions and input notes into stemless slash voices. Using a combination of
slash regions and slash voices can be useful when only some bars require specific rhythms, for

example.
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Further notations
Adding bar repeats

TIP

You can also add slash regions using the Repeat Structures panel on the right of the window,
which you can show by clicking Panels [, then Repeat Structures [@ in the Notations toolbox.

Adding bar repeats

In addition to rhythm slashes to indicate improvisation, you can use bar repeats as a short-hand
to tell players to repeat what they did in the previous bar.

PROCEDURE
1. Inbar 6, select the bar rest on the top piano staff.

2. Press Shift-R to open the repeats popover.

3. Enter % into the popover.
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4. Press Return to close the popover and input a bar repeat region spanning the selection.
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e Keep the bar repeat region selected.

5. Alt/Opt-click the bottom piano staff at the start of bar 6 to copy the bar repeat region at
that position.
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6. Repeatsteps 1to 5 for bars 10 and 14.

RESULT
You have input bar repeat regions for single bars on both piano staves.

TIP

You can also add bar repeat regions using the Repeat Structures panel on the right of the
window, which you can show by clicking Panels [, then Repeat Structures [@ in the Notations

toolbox.
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Further notations
Showing chord symbols above different staves

Showing chord symbols above different staves

Chord symbols automatically appear above rhythm section instrument staves. However, in this
song it is useful to show chord symbols for other instruments too, to help their improvisation.

PREREQUISITE
You are in Setup mode (press Ctrl/Cmd-1).

PROCEDURE

1. Inthe Players panel on the left, select the Trombone player.

Players

Voice

Clarinet (B Flat)

Cornet (B Flat)

2. Right-click the player card and choose Chord Symbols > Show in Chord Symbol and Slash
Regions from the context menu.

e You can also click Player Settings [l in the Players panel to access this option.

3. Repeatstep 2 for the clarinet and cornet players.

RESULT

You have set chord symbols to show in chord symbol or slash regions for the clarinet, cornet, and
trombone. They were already set to show throughout the project for the banjo and piano.

TIP

You can also use this context menu to change which layouts chord symbols appear in.
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Further notations
Adding a drum set

Adding a drum set

This song did not originally include any percussion, but in order to demonstrate how Dorico
handles percussion kits including drum sets, in this task you will add a hypothetical drum set to
the project.

PREREQUISITE

You are in Setup mode (press Ctrl/Cmd-1).

PROCEDURE
1. Inthe Players panel action bar, click and hold or right-click Sort Players [/ and select Band.
e This setting automatically sorts new players according to wind/concert band convention.
2. Press Shift-P to add a new single player and open the instrument picker.
e You can also click Add Single Player EY at the bottom of the Players panel.

3. Enter drum into the instrument picker search box.

Q\ dru m|
Brass Drum Set (Basic)

Electronics Drum Set (Full)
Fretted Instruments Hand Drum
Gamelan Percussion Kick Drum (Low)

Keyboards Kick Drum (Very Low)

Orff Instruments Marching Bass Drum (1 line)

Pitched Percussion Marching Bass Drums

Singers Marching Snare Drum (1 line)

Sketch Marching Snare Drums

Strings Marching Tenor Drum (1 line)
Marching Tenor Drums

Woodwinds Marching Tenor Drums (1 spock)

Marching Tenor Drums (2 spocks)

co o

Create Empty Kit Import Kit...

4. Make sure Drum Set (Basic) is selected, then click Add or press Return.
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e The new drum set is automatically positioned above the piano due to the Band player
sort order.
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Further notations
Adding a drum set

e Because bracket grouping is set to Small ensemble for the full score, the drum set is
now included in a bracket with the other instruments. However, it is preferable to make
a distinction between pitched and unpitched instruments in the score.

TIP

You can change bracket grouping for each layout on the Brackets and Braces page in
Library > Layout Options (key command Ctrl/Cmd-Shift-L).

5. With the drum set player selected, click Add Group [E] at the bottom of the Players panel.

RESULT

You have added a single player, assigned a drum set to them, and put them in their own group
to separate them from the other players’ bracket.

Full score
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TIP

The voice is in its own group for the same reason. You could also designate the voice as a soloist,
as Dorico brackets and numbers soloists separately. You can read more about designating
players as soloists in the Operation Manual.

In Dorico, a percussion kit is a set of multiple unpitched percussion instruments that can be
presented in different ways: each instrument on its own line, in a grid, or on a five-line staff.
The same percussion kit can appear on a five-line staff in the full score but with single-line
instruments in the part layout.

You can identify percussion kits by their green instrument labels in Setup mode.

TIP

e Ifyou click the instrument menu [ in the instrument label and choose Edit Percussion
Kit, you open the Edit Percussion Kit dialog where you can edit various aspects for each
presentation independently, such as the voice for each instrument when using the five-line
staff presentation.

e You can change the presentation type used in each layout in Layout Options > Players >
Percussion (key command Ctrl/Cmd-Shift-L).
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Further notations
Inputting notes on a drum set

Inputting notes on a drum set

Note input on percussion kits, which is what a drum set is in Dorico, works slightly differently
than for other instruments. In this task, you will input a simple drum set part in keeping with the
song's style that demonstrates some useful percussion kit input techniques.

You might find this task easier in the drum set part layout rather than the full score. To switch
layouts in the current tab, use the layout selector in the toolbar. To open the drum set partin a
new tab, click New Tab 3 on the right of the tab bar, then double-click Drum Set in the new tab.

You can show separate empty bars rather than multi-bar rests in the drum set part layout on the
Players page in Layout Options (key command Ctrl/Cmd-Shift-L).

PREREQUISITE
You are in Write mode (press Ctrl/Cmd-2).

PROCEDURE
1. In bar 4, select the bar rest on the drum set staff.
2. Press Shift-N to start note input.

e On percussion kit staves, the caret appears shorter. The current instrument name is also
shown in addition to the caret and the rhythmic grid.

4

==

3. Press Space three times to advance the caret to beat 4.

4

H =

4. Press Up Arrow until the caret is on the hi-hat.

4

5. Press 5 to select eighth notes (quavers).
6. Press Y until the end of beat 1 in bar 8.

e Y is ageneric note input key command that is particularly useful for percussion.
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7. Press6,Y,5,Y,Y again, 6,then Y once more.
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4
]I__-

Anr

8. Move the caret back to bar 4, beat 3.
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Further notations

Inputting notes on a drum set

10.

1.

12.

13.
14.

15.

e For example, you can press Ctrl/Cmd-Left Arrow four times, then Left Arrow twice,
assuming your rhythmic grid resolution is set to eighth notes (quavers).

Press Down Arrow until the caret is on the snare drum.
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e Currently this would input generic snare drum notes, but something subtler would be
better for this song. Because unpitched percussion playing techniques are commonly
notated with different noteheads, you can select unpitched percussion playing
techniques during note input.

Press Alt/Opt-Up Arrow to select the side stick playing technique.
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Make sure quarter notes (crotchets) are selected, then press Y.
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e The default drum set in Dorico is already set up with the most common percussion
playing technique noteheads, so the side stick snare drum note appears with a cross
notehead.

e You could continue using the arrow keys to select other instruments in the kit and then
pressing Y to input notes for them, but when using the five-line staff presentation, you
can also input notes as if they were on a pitched staff.

Press F to input a kick drum note.
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Press Space twice to advance the caret two quarter notes.

Press C, then F to input a snare drum note and kick drum note respectively.
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e Dorico remembers the previous side stick playing technique selected for the snare drum
and continues to use that.
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e By default, five-line percussion kit staves are treated as if they had a treble clef, but you
can change this to the bass clef on the Note Input and Editing page in Preferences
(key command Ctrl/Cmd-,).

Press Space once, then Shift-Alt/Opt-D to input a tom-tom note, then C, then F.
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Further notations
Adding tremolos
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16. Press Space twice, then C, then F.

17. Press Esc or Return to stop note input.

RESULT

You have input notes for different percussion instruments in the same drum set, including
selecting a different playing technique for the snare drum.

0 RARA0 A000

= . e
1T r 3 |

AFTER COMPLETING THIS TASK

You could select bars 5-8 and press R to repeat those four bars until the end of the excerpt,
or instead you could use a bar repeat region indicating the player should repeat the four-bar
phrase. The popover entry for that is %4 in the repeats popover (Shift-R).
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Adding tremolos

In bars 8 and 12 in the verse, the vocal part stops early in the bar. To fill in the space a little, you
can add tremolos to the drum set part.

PROCEDURE

1. Inbar 8, select the quarter notes (crotchets) on the drum set staff.
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2. Press Shift-R to open the repeats popover.
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3. Enter /// into the popover.
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4. Press Return to close the popover.

RESULT
Three stroke single-stem tremolos are input on the selected notes.
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Further notations
Enabling swing playback for the drum set

TIP

You can also add tremolos using the Repeat Structures panel on the right of the window,

which you can show by clicking Panels [, then Repeat Structures [@ in the Notations toolbox.
Tremolos are included in the Repeat Structures panel because they indicate that notes should be
repeated within the given duration.

Enabling swing playback for the drum set

The drum set part has lots of eighth notes (quavers) that could be played swung, as is idiomatic
in blues songs, but the other parts in this song are played straight. In Dorico, you can enable
swing playback only for the drum set, without affecting the other parts.

Dorico provides a number of swing ratios, categorized as “rhythmic feels”, by default.

PROCEDURE
1. Inbar 1, select the bar rest on the drum set staff.
2. Press Shift-T to open the tempo popover.
3. Enter swing into the popover.
swingl I
Dr. 2:1 swing 16ths (fixed) ] - = — A
2:1 swing 8ths (fixed) L 1 1 H
3:1 swing 16ths (fixed)
| 3:1 swing 8ths (fixed) F G#dim7Gm7 F  C7 F
Heavy swing 16ths = = = = = = o
Heavy swing 8ths 7~ i 7~ - £ 7 Li—
Pno | Light sw!ng 16ths
o i o hi i _ .
by H— : : —— i i ] —=
e Like for the playing techniques popover, a menu with valid rhythmic feels appears when
you start entering into the popover.
4. Press Down Arrow until you have selected 2:1 swing 8ths (fixed).
PE-N 2:1 swing 8ths (fixed)| I
Dr. F— 21 swing 16ths (fixed) ] = —= A
e 2:1 swing 8ths (fixed) ! 1 1 H
3:1 swing 16ths (fixed)
| 3:1 swing 8ths (fixed) F G#dim7Gm7 F  C7 F
Heavy swing 16ths = = = = =) = —
Heavy swing 8ths 7~ ia 7~ 7~ £ 7~ Li—
Pno | L!ght sw!ng 16ths
i e o h; ; _ .
R H— : : —— i i ] —=
5. Press Alt/Opt-Return to close the popover.
RESULT

Swing playback with the selected swing ratio is input for only the drum set part. It appears as a
signpost above the drum set.

Dr.

2:1 swing 8ths (fixed)

=
RN

101



Further notations
Removing the drum set from the full score

TIP

e Pressing Alt/Opt in addition to Return means the rhythmic feel only applies to the selected
staff. Pressing Return on its own enables swing playback for all players. You can also use
Alt/Opt-Return to close popovers (or Alt/Opt-click when using the corresponding panel) to
input other voice- and staff-specific notations, such as time signatures and key signatures.

e You can hide/show some or all signposts from the View > Signposts menu.

e Rhythmic feels input using the tempo popover only affect playback in that flow. If you have
Dorico Pro, you can also enable swing playback in the whole project on the Timing page in
Library > Playback Options (key command Ctrl/Cmd-Shift-P).

Removing the drum set from the full score

One of Dorico's strengths is the flexible relationship between players, layouts, and flows. To
demonstrate this, you can remove the drum set from the full score, because it was not in the
original song, but keep the player and their music in the project for reference.
PREREQUISITE

You are in Setup mode (press Ctrl/Cmd-1).

PROCEDURE

1. Inthe Players panel on the left, select the drum set player card.

2. Inthe Layouts panel on the right, deactivate the checkbox in the Full score layout card.

Layouts

> @ Fullscore

RESULT

The drum set player is removed from the full score layout. If you select the full score layout in the
Layouts panel, all players apart from the drum set appear highlighted with activated checkboxes
in the Players panel.

Full score
Players Layouts

P L N

Ty
Cr— = EEssaaasree—=c
> & Voice
) i L > B voice
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> & Clarinet (BFlat)
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> & Comet (BFlat) Gédim7 Gm7
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> B Clarinet (B Flat)

> & Trombone
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Gtdim7 Gm?7 ; > @ Trombone

> & Banjo
> % Banjo
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| Gtdim Gm7 > % prumset

> & Piano > & piano
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Further notations
Looking at the parts

TIP

In Dorico, because you can have as many layouts with whatever combination of players you like,
you could have two full score layouts: one with the drum set and one without.

Part layouts are automatically named after all the players assigned to them, and it is their layout
name that appears in the top left of the first page in part layouts by default, not the player
name. You can rename layouts by double-clicking their cards in the Layouts panel; for example,
if you assigned multiple percussion players to one part layout and want it to be called simply
“Percussion”.

Looking at the parts

You are now almost at the end of this guide, and are hopefully feeling ready to work on your own
projects! So let's take this opportunity to do a quick tour of part layouts, what they share with the
full score, and what is unique to each part.

Firstly, a quick reminder of what layouts are and how they work in Dorico:

Layouts combine the musical content of flows and players with page formatting to produce
paginated music notation. You can have any number of layouts in a single project with any
combination of players and flows. For example, you can include a rehearsal piano player in the
vocal score layout without showing piano staves in the full score. Layouts share musical content
(such as the notes each instrument plays), but can have independent formatting (such as system
breaks and page turns in different places). Full score and part layouts have different default
settings; for example, multi-bar rests are automatically shown in parts, but not in scores.

This means that literal part “extraction”, where each instrumental part is saved to a separate file,
is not necessary: you can keep your full score, all instrumental parts, and any other layouts you
need all in one Dorico project, while retaining the flexibility to edit each one independently.

NOTE

Due to the limitation of two players per project in Dorico SE, and how you have set up your
project(s) to complete the previous tasks, you may need to open a different part layout than
described here. However, the principles of how to look at and edit parts remain the same in all
product versions.

PROCEDURE
1. Press Ctrl/Cmd-T to open a new tab.

e Ifthe tab bar was hidden, it is now shown.

e You can also click New Tab EJ at the right end of the tab bar.
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Further notations
Looking at the parts

Setup  Write Engrave Play  Print

Players

| > L Voice

> L Cornet (B Flat)
> L Trombone

> L Banjo

| > L Drumset

> & Piano

L | J":A

itch

Full score ~ [}

Fullscore | NewTab

Select a recent layout

@

Fullscore

Orselect a layout from the list

Flows

See See Rider

P

Clarinet (B Flat)

o
Layouts

> @ Fullscore

> B Clarinet (8 Flat)

2. Inthelist at the bottom of the new tab, double-click Clarinet (B Flat) to open the Clarinet

part layout.

e You can also select it from the layout selector in the toolbar.

e You are now viewing the Clarinet part layout. It contains only the music belonging to
the Clarinet player. To check this, select the Clarinet part in the Layouts panel on the
right, then look at the Players panel on the left: only the Clarinet player has an active
checkbox, meaning only that player is assigned to the Clarinet part layout.

Players

Group 1

> & Clarinet (8 Flat)

a0 F

Clarinet (8 Flat)

Clarinet (B Flat)]

Laid back blues 4=76)
——

Flows

See See Rider

Layouts

> @ Fullscore

> P orumset

> @ piano

W% BER -

3. Inthe tab bar, click the Full score tab to bring it into view in the music area.

e Afew key differences are probably obvious: by default in Dorico, part layouts have cream
pages, whereas scores have white pages; the Clarinet part has no staff labels, but the
full score has abbreviated staff labels on every system; the first system in the Clarinet
part is slightly indented; the staff size is larger in the Clarinet part; and the casting off is

different, namely which bars appear in each system.
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Further notations
Looking at the parts

10.
1.

12.

e Many of these differences follow generally accepted practices: part layouts require
staves to be large enough to read comfortably from a music stand, but because they
typically only show the music for one instrument, they don't need the staff labels that
are helpful in full scores. These are some of the settings you can adjust for each layout
independently.

e Another aspect of layouts that is independent is the casting off, which you can now try
changing.

Do one of the following:

e If you have Dorico Pro or Dorico Elements, press Ctrl/Cmd-3 to switch to Engrave
mode.

e Ifyou have Dorico SE, press Ctrl/Cmd-2 to switch to Write mode.

In the full score layout, locate bar 11 and remember where it appears; that is, in the middle
of the top system on page 2.

In the tab bar, click the Clarinet tab to bring it into view in the music area.

Select the note at the start of bar 11.

Insert a system break in one of the following ways:

e Ifyou have Dorico Pro or Dorico Elements, press Shift-S.

e Ifyou have Dorico SE, choose Edit > System Break.

"
Ap ® A N

=—=]
e System breaks that you have inserted manually appear as signposts. You can hide/show
some or all signposts from the View > Signposts menu.

e Bar 11is now at the start of a new system. But what has happened to bar 11 in the
score?

In the tab bar, click the Full score tab to bring it into view in the music area.
e Bar 11 is exactly where you left it, in the middle of the top system on page 2.

9 10 11 12
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I made a mis-take, right from the start, Oh, it seems so hard to part,

e System and frame breaks are layout-specific, meaning that inserting them in one layout
doesn't affect any other layouts.

e There's one more key layout-specific aspect of how music can appear that we would like
to introduce you to.

If the lower zone is not shown, press Ctrl/Cmd-8 to show it.

Make sure Properties [ is selected in the lower zone toolbar, so you can access the
Properties panel.

In the Properties panel toolbar, choose Locally for Set local properties.
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Further notations

Looking at the parts

13.
14.
15.

16.

17.

18.

19.

Show: Active ‘ Al

Show: Local Only Global Only AT Set local properties: Globally

This controls the property scope, allowing you to determine whether subsequent local
properties you change take effect only in the current layout (Locally), or in all layouts
(Globally).

Still in the full score layout, Ctrl/Cmd -click all the crescendo hairpins in bar 15.

In the Properties panel, activate Gradual style in the Dynamics group.
Select cresc.... from the menu.
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All the selected hairpins now appear as cresc. text with dotted continuation lines. But
what if you wanted to keep the hairpins in the part layouts?

In the tab bar, click the Clarinet tab to bring it into view in the music area.
15
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Because Gradual style is a local property, and the property scope was set to Locally
when you changed it in the full score, that change only affected the score, leaving the
appearance of the selected crescendos in the corresponding part layouts untouched.

Let's check the rest of the parts.

Press Shift-Alt/Opt-] to switch to viewing the next layout in the current tab.

The next layout is the Cornet, and its crescendo in bar 15 is also still a hairpin.

Keep pressing Shift-Alt/Opt-] to cycle through the rest of the parts and check their hairpins,
until you reach the Piano.

If you want to cycle back the other way, press Shift-Alt/Opt-[.

You can also select an item on a staff, then press W to switch to/from the corresponding
part/score.

As you looked through all the parts, you may have noticed they all had a redundant
flow heading below the project title at the top of the page, displaying “1. See See Rider”.
Although you learned how to hide flow headings in an earlier task, that only affected
one layout.

Press Ctrl/Cmd-Shift-L to open Layout Options.
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Looking at the parts

20.

21.
22.
23.

In the Layouts list on the right of the dialog, click Select All Part Layouts EJ in the action
bar at the bottom.

e This allows you to hide flow headings in all part layouts at the same time. When you
change options in Layout Options, you're doing so for whichever layouts are selected
on the right of the dialog.

e You can also select multiple layouts by clicking and dragging across them, Shift-clicking
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

In the category list, click Page Setup.
In the Flows section, choose Never for Show flow headings.

Click Apply, then Close.

e Inone go, you've hidden all flow headings in all part layouts. You could do the same if
you wanted to, for example, show bar numbers every bar, change the staff size, change
the default gaps between systems, and so on.

[Clarinet (B Flat)|

See See Rider

Gertrude ‘Ma’ Rainey

Laid back blues J=76)

RESULT
You have:

Opened a second tab

Compared a part against the score

Inserted a system break into a part without affecting the score
Changed local properties in the score without affecting the parts
Cycled through layouts using key commands

Changed a Layout Option for multiple selected layouts
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Final tips

We hope that you have enjoyed this guide and have learned some useful ways of working in
Dorico. To finish, we would like to leave you with some final tips for maximizing your time and
output, and to let you know where you can go from here.

e You can find comprehensive documentation on steinberg.help, including separate PDFs for
popover entries and tokens. There are quick reference cards for common key commands
available on the Dorico blog and video tutorials on the Dorico YouTube channel. There is also
a Dorico Resources page with both official and third-party resource links.

e Dorico Pro users: Check the available options in Library > Engraving Options (key command
Ctrl/Cmd-Shift-E ). There are many options for each notation, including default minimum
gap settings; for example, if you want all playing techniques to appear further from the staff,
or all text items to appear closer to the staff. Other options include changing the appearance
of notations, such as whether gradual dynamics are hairpins or cresc. text by default.

e Dorico Pro and Dorico Elements users: You can find default settings for how music is
notated, such as beam groups, how notes are split into ties, or voice columns, in Library >
Notation Options (key command Ctrl/Cmd-Shift-N ).

e Options that are typically different in different layouts, such as page size or bar number
positions, are in Library > Layout Options (key command Ctrl/Cmd-Shift-L ), which is
available in all product versions.

e We strongly recommend using the vertical spacing options in Layout Options to adjust the
gaps between staves and systems. Dorico Pro users can move staves manually in Engrave
mode, but staff spacing overrides can get deleted if the page they originally occurred on
changes, such as if you add a title page at the start of the layout.

e Avoid entering project information directly on the page, especially if you have Dorico
Elements or Dorico SE, because this creates a page override, as mentioned in Page
templates and tokens. Add titles, composers, and other information in the Project Info
dialog (key command Ctrl/Cmd-I). If you have Dorico Pro, you can edit or create new page
templates in Engrave mode to put that information where you want it.

e You can use time signatures to determine how notes are grouped into tie chains and beams
by entering the beat grouping into the time signatures popover, such as 2+3+2/8. If you
don’t want to show the beat grouping in the time signature, enter the beat group inside
square brackets, such as [2+3+2]/8. This can be very useful in pieces with irregular meters
but specific beat grouping: no need to change the beaming on each staff manually!

e If you want to input notes or rests with specific durations, you can use Force Duration
(key command 0O) to override Dorico’s default note and rest grouping.

e When the caret is active, you can press Shift-Up Arrow and Shift-Down Arrow to extend
the caret to multiple staves and input notes and notations (using the corresponding
popovers) on all those staves simultaneously.

e Dorico Pro users: If there are specific symbols you use frequently, create them as custom
playing techniques or custom lines.

e For operations you perform frequently, check the Key Commands page in Preferences (key
command Ctrl/Cmd-,) as you can assign your own key commands for many options.

e For further questions and advice, the Dorico forum is an active and friendly place to go.
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tremolos 100
tuplets 37

numbers 14, 37, 49
flows 54, 55
pages 63

(0

octave lines 42
offsets 62, 66, 67, 69, 85
orchestral order 96, 102
orientations 81

P

page templates 54, 58
pages
formatting 52-58, 60-63
margins 57, 58
numbers 63
size 57

panels 4, 13, 14, 16, 28, 32, 34, 35, 42

paragraph styles 54
parts 7, 11, 52, 102, 103
pauses 78, 79, 87
PDF files 82
percussion kits 96, 98, 101, 102
phrase marks. See slurs
piano
dynamics 28
instrument 10, 56
roll 72
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pitch 16, 18, 21, 50
Play mode 6, 72-74, 79
playback 72-75
muted sounds 88
note durations 79
repeats 49
swing 101
templates 73
tempo 74, 78
players 7, 10, 85, 96, 98, 101
chord symbols 95
groups 96
layouts 10, 11, 102
playhead 72, 74, 75
playing techniques 88, 98
poco 34
popovers 12
bars and barlines 15
chord symbols 89
clefs and octave lines 35, 42
dynamics 28
key signatures 13
lyrics 85
ornaments 32
playing techniques 88
repeats 91, 94, 100
tempo 34
time signatures 14
tuplets 37
portrait orientation 81
Print mode 6, 81, 82
printing 81
preview 4, 81, 82
watermarks 82
projects 4, 7,9, 53, 54, 85

properties 4, 34, 37,49, 69, 74,78, 103

Q

quarter notes 18
quavers. See eighth notes
quintuplets 37

R

rastral size 60
register 16, 18, 22, 40, 42, 50
repeat

barlines 49

bars 94

endings 49

tremolos 100
resetting

dynamics 75

layout options 52

playback templates 73
respelling notes 46
rests 16, 37, 43,79, 87
rhythmic

dots 16

feels 101

grid 4,16, 72

slashes 91
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right hand 47, 69 T
ritenuto 34, 50, 78
rolls 32, 100 tabs 4, 98, 103
ruler 72,75,78,79 templates
pages 54
S playback 73
tempo marks 34
saving moving 50, 79
audio 84 playback 74, 78
PDF files 82 swing playback 101
scores 11,102, 103 tenuto 30
order 96 text 47, 54, 58
second ending 49 lyrics 85
semiquavers. See sixteenth notes moving 50, 69
Setup mode 6, 9-11, 96, 102 ~ watermarks 82
sharps 21 thnty-second notes 16, 43
shortcuts. See key commands ties 27
shortening 28, 50, 79, 91, 108 time signatures 14, 65, 89
sidebars. See panels. See also toolboxes titles 53-55, 63, 72, 81
signposts 101 tokens 53, 54
single players 10 tom-toms 98
sixteenth notes 16, 37, 43 toolbar 4
slashes 91 toolboxes 4
grace notes 40 tracks 72, 75, 78, 79
tremolos 100 transposing 18, 42, 50
slurs 25, 67 treble clef 35
snare drum 98 tremolos 100
sounds 72-74, 79 triplets and tuplets 37, 65, 101
muted 88 two-up 63, 81
spacing 57, 58, 60-63
speed 34, 74, 78,79 U
spelling of accidentals 46
spreads 81 unpitched percussion 96, 98, 101, 102
staccato 30 unslashed grace notes 40
starting up-stems 22, 27, 43, 45, 64, 98
chord input 18
grace note input 40 v
note input 16
projec‘gs ? velocity 75
tuplet input 37 verses 85
status bar 4, 72 vertical spacing 57, 58, 60, 61, 63
ﬁaves16218,22,47,50 video 73, 74
beaming 45, 62 voices 22, 35, 37, 45, 47
chord symbols 95 changing 50
fgrr_natas 87 percussion 96, 98
hmhng102 slashes 91
indents 56 volta lines 49
labels 56 volume 75
°Fder96 VST instruments 73
size 60, 103
spacing 61, 62
stems 22, 45, 47, 64 W
2;§cl(i)nz462 wgtermgrks 82
swing playback 101 wiggly lines 32
switching ml:dcg\:vclssfee tokens
Ir%%f:g' 103 Write mode 6, 12, 13, 16, 85
system breaks 103
system track 12 Z
zones 4, 16
zoom 13
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